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1. Introduction
RamSeries can be used to perform the structural analysis of 
either beams, shells, solids, cables and membranes, or any 
combination of all them, using the finite element method. In 
general, it is considered that linear elastic material properties 
and small displacements assumptions apply to the entire 
structure under analysis. Nevertheless, material non-linearities 
(plasticity), and geometrical non-linearities (large 
displacements) can also be taken into account under some 
circumstances. Non-linear elastic boundary conditions can be 
used as well. Finally, RamSeries can also be used to 
dimensionalize the concrete beams and shells using the 
necessary steel and based on the EHE Spanish regulation. The 
present document intends to include a comprehensive set of 
tutorials trying to cover most of the basic program capabilities. 
If using the interactive Help system, the following link can be 
used to access a comprehensive list of tutorials and to 
automatically load the corresponding models in Tdyn.

Tutorials list

Some theoretical aspects concerning the mechanical behavior 
of beams, shells and solids, and the most important hypotheses 
assumed in the implementation of the RamSeries code are 
briefly described in the appendices of the RamSeries User's 
Manual. Some important issues concerning the definition of 
local axes for beams and shells are also addressed in the User's 
manual. The definition of local axes is going to be used 
systematically in many of the tutorials and is necessary during 
the preparation of many actual models in RamSeries. Hence, it is 
strongly recommended to fully read the RamSeries User's 
manual before starting an intensive use of RamSeries.

All the analysis modules in RamSeries are embedded within GiD, 
a finite element pre and post-processor. Some degree of 
knowledge and some confidence on the use of GiD is assumed 
to ensure a correct development of the case studies presented 
within this manual. In particular, it is assumed that the user has 
some practice on using GiD to create the geometry, generate 
the mesh and visualize the results in the post-processing stage. 
Please, refer to the GiD manual for more details about its usage.

2. Tutorial 1 - Analysis of a beam structure

This tutorial is aimed to perform a simple structural analysis of a 
spatial frame subjected to the action of an homogeneous 
distributed load applied to the horizontal beams located at the 
top of the frame structure. A schematic representation of the 
problem under analysis is shown in the figure below. Beam's 
section and material properties are also included.

Schematic representation of the spatial frame under analysis.

The geometry can be constructed in GiD using the following 
usefull pre-processing commands which are described in detail 
in the GiD User's Manual.

Geometry ► Create ► Line ► 0,0,0 ► 10,0,0

Utilities ► Copy ► Traslation

View ► Rotate ► Trackball

The final model will be composed of 8 lines and all the 
corresponding connection points.

2.1. Problem specification

To load the RamSeries type of analysis, choose the following 
option in the Start Data window:

Simulation type ► Structural analysis

The same option can be alternatively activated through the 
Tdyn data tree by using the following option:

Simulation data ► Simulation type ► Structural analysis

The kind of problem under consideration in this tutorial, 
requires the following basic options to be selected:

- Simulation dimension: 3D

- Structural analysis element types: 
Beams

- Analysis type: Static analysis
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- Material constitutive model: Linear-
elastic model

- Geometrical constitutive model: Linear 
geometry

This setup can be configured from the Start Data window that 
can be accessed from the Data menu as follows:

Data ► Start Data

Start Data window as it appears after configuration of the type of problem required to 
perform structural analysis of the beams in a spatial frame structure

2.2. Boundary conditions and properties

Constraints

First, constraint conditions must be applied. In this case, the 
four inferior points of the structure have a prescription in their 
movements in the three global directions X, Y and Z. Rotations 
in the points are not prescribed.

Constraints ► Fixed constraints

Activation Values
X constraint 1 X value 0.0
Y constraint 1 Y value 0.0
Z constraint 1 Z value 0.0
θx constraint 0 θx value -
θy constraint 0 θy value -

θz constraint 0 θz value -

In this condition, the local axes are no related to the beam local 
axes defined in the properties section. The GLOBAL option 
means that the prescriptions assigned are related to the global 
axes of the problem. This is used in this case. Local axes are 
used to prescribe the displacement or rotation in a direction not 

coincident with any of the global axes. The values part of the 
condition is used to prescribe a fixed amount of displacement 
or rotation. Default units are meters for the X, Y and Z 
displacements and radians for the prescribed rotations. In this 
case, the prescribed displacements and rotations are all zero.

X Constraint, Y Constraint and Z Constraint mean the 
displacements along the axes. θx Constraint, θy constraints and 
theta θz constraints mean the rotations around the axes. Signs 
are as follows (right hand rule):

This condition must be assigned to the four points in the 
bottom part of the structure (minimum Z).

Material properties

Next, section and material properties must be defined. To 
assign the section and material properties to the beams choose:

Materials and properties ► Beams ► Rectangular 
section

The beams will have the following rectangular section 
properties:

-Width Y= 100 mm (width of the rectangular 
section along the Y' direction)

-Width Z= 250 mm (width of the rectangular 
section along the Z' direction)

-E= 2.1e11 N/m2 (Young modulus)

-G= 8.1e10 N/m2 (torsion modulus)

-Specific Weight= 0.0 (the self-weight of the beam 
is not considered)

-Maximum stress= 0.0 (this parameter does not 
have influence in the calculation; it is only usefull 
as a reffernce for the user when verifying stress 
results in postprocess).
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Note: Remember that for an isotropic material: G = E
2 · (1 + ν )

 

In this case ν=0.3

To assign properties to the beams, it is first necessary to define 
local axes. To this aim, in the present case Automatic local axes 
ares used. Hence, following the standard criteria, X’ axes (prime 
refers to local axes) will remain alligned along the horizontal 
beams longitudinal axis. On the other hand, Y’ will be horizontal 
and perpendicular to the beam longitudinal axis, while Z’ will 
have the same direction and sense than the global Z axis.

Once the values of all rectangular section parameters have been 
provided, the condition must be assigned to all the horizontal 
beams.

When assigning the properties on the horizontal beams, the 
Local axes system Automatic is chosen, following the criteria 
given before.

The same must be made with the vertical beams. In this case 
the Y’ axe points to the direction of the X axe, for local axes 
system Automatic.

The conditions that have been assigned can be viewed right-
clicking on the created group: 

Draw ► Draw values / Draw groups / Draw symbols

Load conditions

Finally the loading conditions of the problem must be specified. 
In the present case, all the horizontal beams have a distributed 
load of 50000 N/m along the negative global Z-axis. So the 
condition Global Beam Load will be used:

Loadcases ► Loadcase 1 ► Beams ► Pressure load

Factor 1.0
Loadtype Global

X pressure 0.0 [N/m]
Y pressure 0.0 [N/m]
Z pressure -5.0e4 [N/m]

This condition shall be assigned to all the horizontal beams.

2.3. Mesh generation

For most of the geometrical models, especially if all the beams 
are straight, it is only necessary one beam element per line. To 
obtain it, generate the mesh with a big default element size. It 
should be chosen longer than any of the lines length. For this 
example 100 units can be chosen.

If there are curved lines, it can be necessary to mesh several 
beam elements for every line. To do so, use GiD options to 
control the mesh size like:

Meshing ► Assign unstructured sizes ► Points

Meshing ► Assign unstructured sizes ► Lines

Meshing ► Assign unstructured sizes ► By chordal error

To generate the mesh use:

Meshing ► Generate ► 100

RamSeries only accepts the default 2-noded beam elements. So 
quadratic option is not accepted for beams. Check the GiD 
manual for details.

2.4. Calculate
If the model has not been saved yet, use:

Files ► Save

and give a name to the model. To begin the analysis choose:

Calculate ► Calculate

The analysis runs as a separate process. Then, it is possible to 
continue working with GiD or exit the program. When the 
analysis is finished, a window will appear notifying it. If it has 
not run successfully, one window showing some error info will 
be supplied. Correct the error and run again.

It is possible to visualize, when the process is running, some 
information about its evolution. Press:

Calculate ► View process info

2.5. Postprocess and results analysis

The part of the program dedicated to visualize the results of the 
analysis is called Post-process. Once the calculation is finished, 
to enter in the post-process part and load automatically the 
results select:

Postprocess ► Start

To perform the operation correctly, it is necessary to have the 
model loaded inside the pre-processing part before going to 
post-process.

Visualization of local axes

The first important checking that must be done is to see if the 
local axes for every beam are equal to the ones supposed when 
assigning the properties. Choose:

Postprocess panel ► Results ► Automatic local axes ► Local 
axes mesh - beams ► Local axes

If they are different than supposed, go to the pre-processing 
part, change the properties accordingly and calculate again.

If the drawing of the local axes appear too big or to small, the 
scale drawing factor may be changed by entering a different 
factor in: 

Postprocess panel ► Preferences ► Vectors & Local axes ► 
Factor
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Deformation results

To visualize the deformed (with displacements contour fill on it) 
of the structure, chose the following options:

Postprocess panel ► Meshes ► Line style ► 2nd option

Postprocess panel ► Results ► Static ► Displacements ► 
Contour fill

Postprocess panel ► Preferences ► Deformed ► Draw:[Yes]

Postprocess panel ► Preferences ► Deformed ► Factor:[5]

Postprocess panel ► Preferences ► Deformed ► 
Result:["Static Displacements"]

Deformed of the structure with contour fill of displacements [m]

The deformed of the structure is drawn magnified in the screen 
(factor 5 chosen). The magnifying factor can be automatically 
calculated if "Adimensional factor" is checked instead. 

To see the numerical values of the deformation choose at any 
point, node or element:

Postprocess ► Mesh information

Try also pressing mouse left button over any structure element 
in the screen.

Make the appropriate zooms to visualize properly the values. 

The values are the maximums and lateral values of every beam 
and represent the vector, expressed in global coordinates, of 
the displacement. The default units are meters.

To switch off the labels press:

Mouse right button ► Label ► Off

In order to choose the visualization style for the diagrams, try:

Postprocess panel ► Meshes ► Line style

Strength results

All of the strengths are represented related to the local axes 
systems of every beam. The visualization is made with a 
diagram that will be more separated from the beam as the 
magnitude of the strength increases. It will be drawn in either 
side of the beam depending on the sign. To draw labels with the 
numerical value of the strength that is being visualized, press 
the left mouse button over the screen.

Postprocess panel ► Results ► Static ► Beams ► Max 
stresses ► Sx ► Line diagram

Shear, momentum and axial forces

This is the shear in the X’Z’ plane. Default units are N.

Postprocess panel ► Results ► Static ► Beams ► Z' shear ► 
Line diagram
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In the figure the sign criteria for the shear is shown.

This is the shear in the X’Y’ plane. Default units are N.

Postprocess panel ► Results ► Static ► Beams ► Y' shear ► 
Line diagram

In the figure the sign criteria for the shear is shown.

These are the reactions that appear in the constraints. All nodes 

that have no constraint will have a null reaction. Default units 
are N.

Postprocess panel ► Results ► Static ► Reactions ► 
Vectors

For obtaining the numerical result of all the reactions go to:

Postprocess ► Compose reactions

If labels are displayed, four numbers appears. The first three 
are the reaction vector and the last is the module of this vector.

This is the momentum that rotates around the Z’ axe. Default 
units are N·m.

Postprocess panel ► Results ► Static ► Beams ► Z' 
momentus ► Line diagram

Sign criteria for Z’ momentum is:

Diagram is drawn in the plane X’Y’ and in the side of the beam 
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where the traction is. Positive values of the momentum mean 
that traction is in the –Y’ side (in the negative side of Y’).

This is the momentum that rotates around the Y’ axe. Default 
units are N·m.

Postprocess panel ► Results ► Static ► Beams ► Y' 
momentus ► Line diagram

Sign criteria for Y’ momentum is:

Diagram is drawn in the plane X’Z’ and in the side of the beam 
where the traction is. Positive values of the momentum mean 
that traction is in the –Z’ side (in the negative side of Z’).

This is the axial force in the beam axe. Default units are N.

Postprocess panel ► Results ► Static ► Beams ► Axial force 
► Line diagram

A positive value means traction in the beam. Negative means 
compression.
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3. Tutorial 2 - Analysis of a shell structure

This tutorial aims to demonstrate the use of RamSeries 
capabilities for modelling shell structures. In particular, this 
model describes the analysis of a curved roof taking advantage 
of the double symmetry of the actual problem configuration. A 
sketch of the whole problem is shown in the figure below. One 
fourth of the total shell structure and the corresponding 
symmetry conditions are indicated to illustrate the actual 
problem being solved.

Schematic representation of the problem under analysis. Only one fourth of the entire 
structure is actually modelled taking advantage of the double symmetry resulting from the 

actual configuration of the problem.

The geometry can be constructed in GiD using the following 
usefull pre-processing commands which are described in detail 
in the GiD User's Manual.

Geometry ► Create ► Line

Geometry ► Create ► Arc

Utilities ► Copy ► Rotate ► Do extrude lines

Geometry ► Create ► NURBS surface ► By contour

The final model will be composed of 1 surface, 4 lines and all of 
its connecting points. Be careful to position the structure 
related to the global axes as seen in the figure to make it easier 
to follow the set up of the example as explained in the 
remaining part of the tutorial. The coordinates of the four 
vertices of the shell under analysis are reported in the following 
table:

X coordinate 
(m)

Y coordinate 
(m)

Z coordinate 
(m)

Point A 0.0 -25.0 25.0
Point B 16.07 -25.0 19.15
Point C 16.07 0.0 19.15
Point D 0.0 0.0 25.0

3.1. Problem specification

To load the RamSeries type of analysis, choose the following 
option in the Start Data window:

Simulation type ► Structural analysis

The same option can be alternatively activated through the 
Tdyn data tree by using the following option:

Simulation data ► Simulation type ► Structural analysis

The kind of problem under consideration in this tutorial, 
requires the following basic options to be selected:

Data ► Start data

- Simulation dimension: 3D

- Structural analysis: Shells

- Analysis type: Static analysis

- Material constitutive model: Linear-
elastic model

- Geometrical constitutive model: Linear 
geometry

This setup can be configured from the Start Data window as 
explained in detail in the Tutorial 1 - Analysis of a beam 
structure tutorial. Alternatively, all these options can be 
modified in the data tree if necessary.

3.2. Boundary conditions and properties

Constraints

Constraints for shells can be either applied to points or lines. In 
this example, fixed constraints are applied to 3 boundary edges 
of the shell by using the following option of the data tree:

Constraints ► Fixed constraints

In particular, a condition resembling a rigid wall is applied to 
the edge AB. To this aim, X and Z displacements must be 
restrained as well as the rotation about Y global axis. Hence, the 
degrees of freedom are activated as indicated in the following 
table (non-activtated degrees of freedom remain free) and the 
corresponding displacements are fixed to zero:

Activation Values
X constraint 1 X value 0.0
Y constraint 0 Y value -
Z constraint 1 Z value 0.0
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θx constraint 0 θx value -
θy constraint 1 θy value 0.0
θz constraint 0 θz value -

On the other hand, lines CD and DA must have symmetry 
conditions. To this aim, degrees of freedom must be prescribed 
as shown in the following tables for CD and DA edges 
respectively:

Activation Values
X constraint 0 X value -
Y constraint 1 Y value 0.0
Z constraint 0 Z value -
θx constraint 1 θx value 0.0
θy constraint 0 θy value -

θz constraint 1 θz value 0.0

Activation Values
X constraint 1 X value 0.0
Y constraint 0 Y value -
Z constraint 0 Z value -
θx constraint 0 θx value -
θy constraint 1 θy value 0.0
θz constraint 1 θz value 0.0

Finally, edge BC remains completely free. In all these cases, the 
degrees of freedom refer to the global system axes.

Shell material properties

The shell under analysis in this tutorial is considered to be 
isotropic. To assign the section and material properties of an 
isotropic shell, use the following option of the data tree and 
setup the corresponding properties as shown below:

Materials and properties ► Shells ► Isotropic shell

- Thickness = 250 mm 

- E = 4.32e8 N/m2 (Young modulus)

- ν = 0.0 (Poisson coefficient)

- Specific Weight = 0.0 (self-weight of the shell is 
not considered here)

Remember that for an isotropic material: G = E
2 · (1 + ν )

 which 

in this case results to be G = E
2

Note also that the default local axes system is used. Following 
the axes criteria explained in detail in the RamSeries' users 
manual, X’ local axis will point towards the positive global X axis. 
Z’ axis will be normal to the elements and Y’ will be contained in 
the plane XZ.

Once the shell material properties are filled in, the condition 
must be assigned to the surface that defines the shell. Assigned 
conditions can be viewed at any moment by right-clicking on 
the created group and using the following option from the 
contextual menu: 

Draw ► Draw values / Draw groups / Draw symbols

Load conditions

The load condition of the structure under analysis in this 
problem consists on a distributed load of 90 N/m2 directed to 
the negative direction of the global Z axis. Hence, a pressure 
load condition can be applied by using the following option of 
the data tree:

Loadcases ► Loadcase 1 ► Shells ► Pressure load

Factor 1.0
Loadtype Global

X pressure 0.0 [N/m]
Y pressure 0.0 [N/m]
Z pressure -90.0 [N/m2]

The resulting condition must be assigned to the surface that 
defines the shell under analysis.

3.3. Mesh generation

RamSeries can generate both, 3-noded and 6-noded triangular 
meshes. hence, it is possible to mesh the surface of the sheel 
under analysis with either linear or quadratic triangles. The use 
of linear or quadratic elements can be controlled by using the 
following main menu option:

Mesh ► Quadratic type ► Normal | Quadratic | Quadratic 9

Note that the Quadratic9 option only applies to quadrilateral 
elements for which an extra node is located at the center of the 
element.

Note also, that in the structural analysis data tree an option 
exists to control the type of triangular element being used 
internally by the structural solver:

General data ► Analysis ► Element types ► Internal 
triangular element

This option is set by default to DKT. Nevertheless, a 6-noded 
option is also available in which case 3-noded triangular meshes 
are internally converted to 6-noded meshes. Finally, a third 
option exists that allows to use an improved Drill-rotation 
triangular element.

As usual, the more elements are used to mesh the geometry, 
better accuracy in the results will be obtained. Conversly, larger 
computer times and RAM memory resources will be needed. 
The following option can be used at the end of the calculation to 
get information on the memory and computer time 
requirements:

Calculate ► View process info

It is usually convenient to mesh using smaller elements in those 
zones of the shell where larger result's gradients are anticipated 
to exist. Mesh element sizes can be controlled using the 
following options to assign mesh sizes to the various 
geometrical entities (points lines surfaces and volumes) of the 
model.

Meshing ► Assign unstructured sizes ► Points

Meshing ► Assign unstructured sizes ► Lines

Meshing ► Assign unstructured sizes ► By chordal error

In this model, a default size of 1 is chosen to generate triangular 
meshes. To actually generate the mesh using such a default 
mesh size, use the following main menu option indicating the 
maximum element size allowed:

Meshing ► Generate ► 1
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The resulting mesh contains 642 nodes and 1146 linear 
triangular elements.

To get an insight on the precision of the results related to the 
number of nodes in the mesh, take a look at the benchmark 
graphics provided in the appendix .

3.4. Calculate
If the model has not been saved yet, use:

File ► Save

and give a name to the model.

To begin the analysis choose:

Calculate ► Calculate

The analysis runs as a separate process. Then, it is possible to 
continue working with GiD or exit the program. When the 
analysis is finished, a window will appear notifying it. If it has 
not run successfully, a window showing some error info will be 
supplied. Correct the error and run again.

It is possible to visualize, when the process is running, some 
information about its evolution. To get it, press:

Calculate ► View process info

One of the most important information that can be obtained in 
this window is the amount of RAM memory, expressed in 
Megabytes, needed by the solver. The total amount of memory 
required by the analysis code is somewhat bigger. For skyline 
solver, the total amount is about 10% more. For Sparse solver, it 
is about the double of memory. This data gives an idea of the 
maximum problem that can be solved in a given computer.

This specific analysis needs about 40Mb of memory to execute 
(it should be necessary a RAM of 64Mb or 96Mb to run it 
correctly). Using an Sparse solver, it would need much less 
memory.

3.5. Postprocess and results analysis

The part of the program dedicated to visualize the results of the 
analysis is called Post-process. Once the calculation is finished, 
to enter in the post-process part and load automatically the 
results select:

Postprocess ► Start

To perform the operation correctly, it is necessary to have the 
model loaded inside the pre-processing part before going to 
post-process.

Visualization of local axes

The first important checking that must be done is to see if the 
local axes for every shell element are equal to the ones 
supposed when assigning the properties. Choose:

Postprocess panel ► Results ► Static ► Shells ► Local axes 
► Local axes

Local X’ axis is drawn in color red, Y’ axis in green and Z’ axis in 
blue.

If they are different than supposed, go to the pre-processing 
part, change the properties accordingly and calculate again.

Note: It is possible to enter a different factor to change the 
display size of the axes. Just enter the new factor in:

Postprocess panel ► Preferences ► Vectors & Local axes ► 
Factor

Deformation results

To visualize the deformation of the structure select the 
following option and visualization preferences in the 
postprocess panel:

Postprocess panel ► Results ► Static ► Displacements ► 
Contour fill

Postprocess panel ► Preferences ► Deformed ► Draw:[Yes]

Postprocess panel ► Preferences ► Deformed ► Factor:[10]

Postprocess panel ► Preferences ► Deformed ► 
Result:["Static Displacements"]

The deformation of the structure is drawn magnified in the 
screen in accordance to the deformation factor provided in the 
postproces preferences panel. The magnification factor is 
automatically calculated if the "Adimensional factor" option is 
selected instead of providing a fixed factor. The deformation 
and the original configuration of the structure can be drawn 
together for the sake of reference. To this aim, select the 
following option if the preferences section of the postprocess 
panel: 

Postprocess panel ► Preferences ► Deformed ► Draw 
original

Another way to see the magnitude of the deformation of the 
shell is to use:
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Postprocess panel ► Results ► Static ► Displacements ► 
Disp z ► Contour fill

To see the numerical values of the deformation choose at any 
point, node or element:

Postprocess ► Mesh information

Try also pressing mouse left button over any structure element 
in the screen.

Make the appropriate zooms to visualize properly the values. 

To switch off the labels press:

Mouse right button ► Label ► Off

In order to choose the visualization style for the shell, try:

Postprocess panel ► Meshes ► Display style

It is quite usual that there are local concentrations of strengths 
near the constraint points or near the nodal forces. In these 
cases, the scale of color has not enough contrast in the rest of 
the shell. To avoid it, it is possible to change the limits of the 
values of the contour fill. The zones of the shell that have values 
higher that the maximum limit or lower that the minimum one, 
will appear either black, transparent or in a defined colour, 
depending on the user preferences.

To define the maximum and minimum limits activate the 
corresponding checkbox, and define the limits:

Postprocess panel ► Results ► Limits

Right-click over the "Limits" label, leads to the following 
available options:

Recalculate limits

Recalculate limits-all steps (only dynamic analyses)

Multiple results

Only active meshes

Legend colours

Redraw

 Strength results

All the strengths are reported refered to the local axes system 
of every shell (except the strengths in main axes). The 
visualization will be generally with a Contour Fill of every 
component of the strength although there are other ways to 
visualize them. To see the numerical value of the strength that is 
being visualized, choose:

Mouse right button ► Label ► All

To hide the numerical results select:

Mouse right button ► Label ► Off

Both commands can be found in the menu that appears when 
pressing the secondary mouse button over the screen.

The strengths are the following:

Name Default units Remarks
Axial force Nx’, Ny’, Nx’y’ N/m Axial force 

in all the 
shell 
thickness 
per unit 
width of 
the shell

Momentu
m

Mx’, My’, Mx’y’ N·m/m Momentu
m per unit 
width of 
the shell

Shear Qx’, Qy’ N/m Shear 
strength 
per unit 
width of 
the shell

Note: See that Mx’ momentum is contained inside plane X’Z’. 
This criteria is different from the strength criteria in beams or in 
constraints, where the rotation in X’ is the one that rotates 
around X’ axe. The rotation axe criteria for shell momentum are 
inherited from the plate criteria. In that case, as there are only 
two rotations in a plate, this choosing looked appropriate. For 
rotations in 3D, as there are 3, it is necessary to use the other 
criteria.

As a example, this is the Mx’momentum on the shell:

Postprocess panel ► Results ► Static ► Shells ► Momentus 
► Mx ► Contour fill
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 Shear, momentum and axial forces

The shear forces do not follow the same tensor approach 
because they are two forces, one for each local axis. As they can 
be represented in any local axes system, it is possible to see in 
RamSeries the shear represented in the same local axes base 
than the Main momentum. To do so, select:

Postprocess panel ► Results ► Static ► Shells ► Shear in 
main ► Qm1 -- Qm2

Following the theory of elasticity, the axial force is represented 
in a given base X’Y’ by the following tensor:

It is always possible to find another base X’’Y’’ where the tensor 
is represented as:

These are the eigenvalues of the matrix and the new base is 
made with the eigenvectors. Its values represent the maximum 
and the minimum axial value for that point of the shell.

It is possible to see these values with:

Postprocess panel ► Results ► Static ► Shells ► Axial force 
► Main stresses

Note: As the local axes system for the main axial forces change 
from element to element, in some cases where this change is 
too big the smoothing in the contour fill is not being done. For 
this reason, some discontinuities of the results can be 
appreciated.

The same ideas than for the Main axial force can be applied to 
the momentum. In this case, to display the main momentum 
use:

Postprocess panel ► Results ► Static ► Shells ► Momentus 
► Mi -- Mii

This is the reaction momentum. It is expressed as a vector 
showing the rotation axe and a module that means the rotation 
amount. Default units are N·m.

Postprocess panel ► Results ► Static ► M Reactions ► 
Vectors

These are the reactions that appear in the constraints. All nodes 
that have no constraint will have a null reaction. Default units 
are Newtons.

Postprocess panel ► Results ► Static ► M Reactions ► 
Vectors

If labels are displayed, four numbers appears. The first three 
are the reaction vector and the last is the module of this vector.

4. Tutorial 3 - Coupled beam and shell analysis

This example represents the analysis of a spacial frame 
supporting a plate with a hole. A schematic representation of 
the problem is shown in the figure below. Section, material 
properties and constraints are also indicated.

4.1. General ideas
The analysis of a coupled beam and shell analysis comes quite 
straightforward from the analysis of beams and the analysis of 
shells separated. Some points to take into care are:

Beams and shells must share the connecting points when a 
physical connection needs to be defined. Also, a beam that 
is boundary of a shell must be represented with a line that 
is boundary of a surface.

If a beam is represented by a line that is the boundary of 
one surface that represents a shell, the line is not going to 
be meshed, by default, with beam elements. It is necessary 
to explicitly tell GiD to mesh it. To do so, use:

Meshing ► Mesh criteria ► Mesh ► Lines

And select the lines that represent these beams.

It is not accepted to mesh the mixed elements with 
quadratic elements. So, linear elements must be used. It is 
advisable to set the option Internal 6-noded elements in 
order to have higher precision for the shell analysis.
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For the beams that are boundary of a shell surface, it is 
necessary to mesh as many beam elements as boundaries 
of the triangle elements. So, every beam will be subdivided 
in several line elements. In these cases, it is better to use a 
small number for the option Beam res granularity. For 
example 2 or 4.

Results are visualized in the same way that both analyses 
do.

4.2. Results from the example of coupled beams 
and shells
The following pictures are several results for the defined 
analysis:

Momentum Mx’ on the shell Momentum My’ on the beams

Torque on the beams
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5. Tutorial 4 - Dynamic analysis of a coupled 
beam and shell structure
This example performs a dynamic analysis of the structure of 
the previous example.

The geometry corresponding to this tutorial can be found here 
(IGES format):

RamSeries-Tutorials4-dynamic_beams_and_shells.igs

Alternativelly, the model ready to be meshed and run, can be 
automatically loaded into the GUI by left-clicking on the button 
below.

Load model

This example uses the same materials and displacements 
constraints as the previous example.

5.1. Analysis data

In this example the problem data information is similar to that 
of the previous example. The required information for the 
dynamic analysis can be defined in the analysis options:

General data ► Dynamic analysis data ► General

Type Modal analysis
Δt 0.1 s

Number of steps 25
Type of modal analysis Number of modes

Number of modes 5

General data ► Dynamic analysis data ► Integration data

Integration method Implicit (Newmark)

Initial conditions None

General data ► Dynamic analysis data ► Damping data

Damping type Modal damping

Damping ratio 0.05

5.2. Dynamic Loads

One face of the shell carries a distributed load of 1000 N/m 
along the negative global X-axis. A Beam pressure Load will be 
assigned to such face.

Loadcases ► Loadcase 1 ► Beams ► Pressure load

Factor Click Function icon to insert 
the following info:

Function on time Sinusoidal load
Amplitude 1.0
Frequency 0 .5 Hz

Phase angle 0.0 deg
Initial time 0.0 s
End time 4 s

X pressure -10000 N/m
Y pressure 0.0 N/m
Z pressure 0.0 N/m2

5.3. Results of the example “Dynamic analysis of 
coupled beam and shell structure”

The following pictures show several results for the performed 
analysis:

Vibration mode # 1 - 3.04 Hz

Vibration mode # 2 - 4.04 Hz
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Vibration mode # 3 - 19.33 Hz

Displacement field after 5 seconds

Momentum Mx after 5 seconds
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6. Tutorial 5 - Fatigue Damage Assesment

In this example the dynamic analysis of a shell is performed. 
The fatigue damage caused over the structure is also evaluated 
by using the tools provided in Tdyn for fatigue damage 
assesment. The shell structure under analysis is similar to that 
of example Tutorial 4 - Dynamic analysis of a coupled beam and 
shell structure but without the supporting beams since the shell 
is completely constrained at two of its boundary edges.

The model, ready to be meshed and run, can be automatically 
loaded into the GUI by left-clicking on the button below.

Load model

6.1. Beams properties

To assign the section and material properties to the beams 
choose:

Materials and properties ► Beams ► Rectangular section

In this example the beam is considered to have a rectangular 
section with an area A = 0.01 m2. The actual material being used 
is the predefined S-355N steel. Hence, beam properties must be 
defined as indicated in the figure below and must be applied to 
the boundary of the hole located at the center of the shell 
structure.

Section and material properties to be assigned to the beams located at the boundary of the 
shell structure

Beam applied to the boundary of the circular hole located at the center of the shell 
structure

Local axes system 'Automatic' is chosen. Following the 
criteria given before, X’ axes will go along the boundary and 
Y’ axe will be horizontal. Z’ axe will have the same direction 
and sense than Z axe.
The 'Width y' is the width of the rectangular section 
following the Y’ direction. So, it is the horizontal width and 
its value is 0.1 m. 'Width z' is the width in the Z’ direction. In 
this case its value is also 0.1 m.

G  is the torsion modulus (8.1e10 N/m2) and E  is the Young 
modulus (2.1e11 N/m2). Remember that for an isotropic 
material G = E

2 · (1 + ν )
, where ν=0.3

If the Specific Weight is left to 0.0, then the self-weight of 
the beam is not considered. Its default units are N/m3.

Once the values are introduced in the 'Rectangular section' 
definitions window, the condition must be assigned to line that 
defines the contour of the circular hole at the center of the shell.

Assigned conditions can be verified by right-clicking on the 
group under consideration and selecting the following option in 
the contextual menu.

Draw ► Draw values / symbols / groups

6.2. Shell properties

To assign the section and material properties to the shell 
choose:

Properties ► Shells ► Isotropic shell

Shell properties for the present example read as follows:
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Thickness and material properties to be assigned to the shell structure under analysis

Local axes system 'Default' is chosen. Following the criteria 
given before, X’ axe will point towards positive global Y axe. 
Z’ axe will be normal to the elements and Y’ will be 
contained in the plane XZ.

'Thickness' is the width of the shell in the orthogonal 
direction to the shell surface. In this case its value is 0.2 m.

E  is the Young modulus (4.32 e8 N/m2) and ν  is the Poisson 
coefficient with a value 0.3 in this case.
If the Specific Weight is left to 0.0, then the self-weight of 
the shell is not considered. Its default units are N/m3.

Once the values are filled in, the condition must be assigned to 
the surface that defines the shell.

The conditions that have been assigned can be verified at any 
moment by right-clicking on the group under consideration.

Draw ► Draw values / symbols / groups

6.3. Fatigue assesment data

To perform a fatigue damage assesment analysis it is first 
necessary to choose the zone where the analysis is actually 
going to be performed. Note that we are usually not interested 
on doing the fatigue damage assesment over the entire 
structure but only on a given local area. Note also that the 
fatigue damage assesment can be performed over lines, thus 
representing welded joints, or over surfaces, then representing 
steel shells. To this aim, first activate the 'Fatigue Damage 
Assesment' capability by selecting the following option in the 
data tree:

General data ► Analysis ► Damage assesment

If a SN curves file is available, it can be loaded from:

General data ► Analysis ► SN curves file

Actually, a SN curve file is already provided with the software 
distribution in the scripts directory of the problemtype.

Finally, in order to be able to perform the fatigue damage 
analysis, it is necessary to define the analysis time for each 
combined load. 

Welded joints

Materials and properties ► Beams ► Damage assement ► 
Welded joints

Assign this condition to any line of the geometry which is to be 
treated as a welded joint and be under fatigue check.

Shells

Materials and properties ► Shells ► Damage assement ► 
Shells

Assign this condition to any surface of the geometry which is to 
be checked for fatigue damage under cyclic loads.
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In both cases, the coefficients regarding SN curves can be either 
inserted manually, or automatically by choosing the desired 
curve to use from the curves file (this SN curves file is included 
in the example, DNV_SNcurves.csv), if it has been inserted:

For more information regarding Fatigue Damage Assesment, 
please review: Appendix 10: Fatigue Damage Assesment.
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6.4. Displacement constraints

Constraints for shells can be either applied to points or lines. In 
this example, the constraints are applied to the two short 
boundary edges of the shell. Both lines will have all six degrees 
of freedom restrained.

The symbols indicate that the corresponding edges are constrained

In this condition, the local axes have no relationship with the 
shell local axes defined in the properties section. The GLOBAL 
option means to prescribe related to the global axes of the 
problem. This is used in this case. Local axes are used to 
prescribe the displacement or rotation in a direction not 
coincident with any of the global axes. The values part of the 
condition is used to prescribe a fixed amount of displacement 
or rotation. Default units are meters for the X, Y and Z 
displacements and radians for the prescribed rotations. In this 
case, the prescribed displacements and rotations are all zero.

X Constraint, Y Constraint and Z Constraint mean the 
displacements along the axes. Theta x Constraint, theta y 
constraints and theta z constraints mean the rotations around 
the axes. Signs are as follows (right hand rule):

This condition must be assigned to the lines described in the 
picture. In all cases, the prescribed displacements and rotations 
are zero.

6.5. Dynamic Loads

The shell is subjected to the action of a distributed load 
perpendicular to the surface of the shell with a magnitude P = 
-50000 Pa.

Pressure load definition window

Definition of the sinusoidal signal used to modulate the pressure load

6.6. Problem data
In this example the problem data information is similar to that 
of the previous example. The required information for the 
dynamic analysis can be defined in the analysis options:

General data ► Dynamic analysis data ► General

General data ► Dynamic analysis data ► Integration data
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General data ► Dynamic analysis data ► Damping data

6.7. Results
Due to the cyclic load applied, the stresses variation occured on 
the shells and the joints, may lead these structural elements to 
suffering from early crack creation/propagation.

For performing the fatigue check, go to:

Postprocess ► Damage assesment

Fatigue damage in welded joints

Fatigue damage in shells

The contour fill maps above show the critical zones where this 
fatigue is more likely to occur. The possible range for this result 
is 0-1. If the value is 1 -corresponding to red in the image above- 
the structural element is likely to fail under fatigue loads.
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7. Tutorial 6 - Analysis of a solid

The example used to describe the solid analysis will be a 
cantilever beam with diminishing cross section.

The geometry corresponding to this tutorial can be found here 
(IGES format):

RamSeries-Tutorials6-solids.igs

Alternativelly, the model ready to be meshed and run, can be 
automatically loaded into the GUI by left-clicking on the button 
below.

Load model

If you prefer to build the model from scratch, the geometry can 
be simply constructed in GiD using the following usefull pre-
processing commands which are described in detail in the GiD 
User's Manual. The final model will be composed of 1 volume, 6 
surfaces, 12 lines and all of its connecting points. Some useful 
commands are:

Geometry ► Create ► Line

Geometry ► Create ► NURBS surface ► By contour

Geometry ► Create ► Volume ► By contour

Be careful to position the structure related to the global axes as 
seen in the picture. Then, it will be easier to follow the example. 
The eight points will be:

A 0.000000 0.000000 0.000000
B 5.000000 0.000000 0.000000
C 5.000000 0.500000 0.000000
D 0.000000 0.500000 0.000000
E 0.000000 0.000000 –1.000000
F 5.000000 0.000000 –0.500000
G 5.000000 0.500000 –0.500000
H 0.000000 0.500000 -1.000000

7.1. Loading Solids analysis

To load the RamSeries type of analysis, choose:

Simulation type ► Structural analysis

For this kind of problem, the Solids analysis can be set up from 
the Start Data window, as shown in the Beams tutorial, with the 
following options in this case:

Data Start data

- Simulation dimension: 3D

- Structural analysis: Solids

- Analysis type: Static analysis

- Material constitutive model: Linear-
elastic model

- Geometrical constitutive model: Linear 
geometry

7.2. Displacement constraints

Constraints for solids can be either applied to points or lines or 
surfaces. In this example, the constraints are applied to one 
surface of the boundary of the solid.

Constraints ► Fixed constraints

Activation Values
X constraint YES X value 0.0
Y constraint YES Y value 0.0
Z constraint YES Z value 0.0

The condition must be assigned to the vertical surface with 
minimum X value.

In the local axes field, The GLOBAL option means to prescribe 
related to the global axes of the problem. This is used in this 
case. Local axes are used to prescribe the displacement in a 
direction not coincident with any of the global axes. The values 
part of the condition is used to prescribe a fixed amount of 
displacement. Default units are meters for the X, Y and Z 
displacements. In this case, the prescribed displacements are all 
zero.

X Constraint, Y Constraint and Z Constraint mean the 
displacements along the axes. Signs are as follows:
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7.3. Solid properties

To assign the section and material properties to the solid 
choose:

Materials and properties ► Solid ► Isotropic solid

-E= 2.1e11 N/m2 (Young modulus)

-ν= 0.3 (Poisson coefficient)

-Specific Weight= 8.0e4 N/m3

Note: Remember that for an isotropic material: G=E/(2·(1+ν))

Once the values are filled in, the condition must be assigned to 
the volume that defines the solid.

The conditions that have been assigned can be viewed right-
clicking on the created group: 

Draw ► Draw values / Draw groups / Draw symbols

7.4. Punctual Loads
Points B and C in the solid have a punctual load of 100000 N 
each one in the negative Z direction. So the condition Punctual 
Load will be used.

Loadcases ► Loadcase 1 ► Solids ► Punctual load

Factor 1.0
X pressure 0.0 [N]
Y pressure 0.0 [N]
Z pressure -1.0e5 [N]

This condition will be assigned to the two points B and C.

7.5. Mesh generation

RamSeries accepts 4-noded and 10-noded tetrahedron as the 
elements that define the solid. So, it is possible to mesh the 

volumes with either Normal or Quadratic tetrahedrons (see ).

Meshing ► Quadratic elements

Use always quadratic tetrahedrons except when, due to the 
complexity of the geometry, the minimum final amount of 
nodes is too big for the computer capacity. They give much 
more precision in the results for the same amount of nodes.

If more elements are used to mesh the geometry, more 
accuracy in the results will be obtained. At the same time, more 
computer time and RAM memory is needed. Use

Calculate ► View process info

after doing a preliminary analysis, in order to obtain 
information of the memory requirements and the computer 
time needed.

It is also interesting to mesh smaller elements in the zones of 
the solid that will have a bigger gradient in the results.

To estimate the precision of the results related to the number of 
nodes in the mesh and the type of tetrahedrons, check the test 
graphics given in following sections.

To obtain the desired sizes of the elements, use GiD options to 
control the mesh size like:

Meshing ► Assign unstructured sizes ► Points

Meshing ► Assign unstructured sizes ► Lines

Meshing ► Assign unstructured sizes ► Surfaces

Meshing ► Assign unstructured sizes ► By chordal error

To generate the mesh use:

Meshing ► Quadratic elements ► Quadratic

Meshing ► Generate ► 0.2

In this model, 10-noded tetrahedrons are used and a default 
size of 0.1 is chosen for the elements. The total amount of 
nodes is 27166 and the total amount of tetrahedrons is 18041.

7.6. Calculate
If the model has not been saved yet, use:

Files ► Save

And give a name to the model.

To begin the analysis choose:

Calculate ► Calculate

The analysis runs as a separate process. Then, it is possible to 
continue working with GiD or exit the program. When the 
analysis is finished, a window will appear notifying it. If it has 
not run successfully, one window showing some error info will 
be supplied. Correct the error and run again.

It is possible to visualize, when the process is running, some 
information about its evolution. Press:

Calculate ► View process info

To get it. One of the most important information that can be 
obtained in this window is the amount of RAM memory, 
expressed in Megabytes, needed by the solver. The total 
amount of memory required by the analysis code if somewhat 
bigger. For skyline solver, the total amount is about 10% more. 
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For Sparse solver, it is about the double of memory. This data 
gives an idea of the maximum problem that can be solved in a 
given computer.

This specific analysis needs about 30Mb of RAM memory to 
execute in the direct solver. In the conjugate-gradients solver, it 
would take about 180 iterations to finish and much less 
memory.

7.7. Postprocess

The part of the program dedicated to visualize the results of the 
analysis is called Post-process. Once the calculation is finished, 
to enter in the post-process part and load automatically the 
results select:

Postprocess ► Start

To perform the operation correctly, it is necessary to have the 
model loaded inside the reprocessing part before going to post-
process.

Choose the view style Body bound if it is not still selected. With 
this type of view, Contour fills on solids are visualized better:

Postprocess panel ► Meshes ► Display style

7.8. Deformation of the structure
To visualize the deformed of the structure check:

Postprocess panel ► Results ► Static ► Displacements ► 
Contour fill

Postprocess panel ► Preferences ► Deformed ► Draw:[Yes]

Postprocess panel ► Preferences ► Deformed ► 
Factor:[200]

Postprocess panel ► Preferences ► Deformed ► 
Result:["Static Displacements"]

The deformed of the structure is drawn magnified in the screen. 
The magnifying factor is automatically calculated if 
"Adimensional factor" option is selected.

7.9. Contour fill of the displacements

Another way to see the magnitude of the deformation of the 
solid is to use:

Postprocess panel ► Results ► Static ► Displacements ► 
Disp z ► Contour fill

To see the numerical values of the deformation choose:

Postprocess ► Mesh information

Try also pressing mouse left button over any structure element 
in the screen.

Make the appropriate zooms to visualize properly the values. 

To switch off the labels press:

Mouse right button ► Label ► Off

7.10. Visualization of strengths

All of the strengths are represented related to the global axes 
systems of the model (except Von Misses that do not depend on 
the axes). The visualization will be generally with a Contour Fill 
of every component of the strength although there are other 
ways to visualize them. 

The strengths are the following:

Name Default units Remarks
Normal 
strengths

Sx,Sy,Sz N/m2 Also called σx
σyσz are the 
stresses for 
every global 
axe

Tangential 
strengths Txy, Txz, Tyz N/m2 Also called τxy

τxzτyz

Main stresses Si, Sii, Siii N/m2 Main stresses 
expressed in 
the main axes

The sign criteria for these strengths is:
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As an example, this is the σxstrength on the solid:

Postprocess panel ► Results ► Static ► Stresses ► Sx ► 
Contour fill

7.11. Self defined Contour fill limits for 
strengths

It is quite usual that there are local concentrations of strengths 
near the constraint points or near the nodal forces. In these 
cases, the scale of color has not enough contrast in the rest of 
the shell. To avoid it, it is possible to change the limits of the 
values of the contour fill. The zones of the shell that have values 
higher that the maximum limit or lower that the minimum one, 
will appear either black, transparent or in a defined colour, 
depending on the user preferences.

To define the maximum and minimum limits activate the 
corresponding checkbox, and define the limits:

Postprocess panel ► Results ► Limits

Right-click over the "Limits" label, leads to the following 
available options:

Recalculate limits
Recalculate limits-all steps (only dynamic analyses)

Multiple results

Only active meshes

Legend colours

Redraw

7.12. Main stresses
Following the theory of elasticity, the strengths in a differential 
volume can be expressed in global axes by this tensor:

It is always possible to find another base X’Y’Z’, different for 
every node, where the tensor is represented as:

These are the eigenvalues of the matrix and the new base is 
made with the eigenvectors. Its values represent the maximum 
and the minimum strengths values for that point of the solid.

It is possible to see these values with:

Postprocess panel ► Results ► Static ► Stresses ► Si ► 
Contour fill

7.13. Von Mises
Von Misses strength is a scalar tension that gives a mean value 
of all the strengths in a given point of the solid. It can be 
compared with the maximum acceptable strength for that 
material. Its expression is given by:

To see a contour fill of its value, choose:

Postprocess panel ► Results ► Static ► Stresses ► Von 
Mises ► Contour fill
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Note: The maximum value to visualize has been set manually to 
2.1e7 in order to appreciate a good contrast in the colors. The 
zones that have a bigger Von Misses value (near the application 
of the point loads), are in the same colour as the maximum 
(red). 

7.14. Reactions
These are the reactions that appear in the constraints. All nodes 
that have no constraint will have a null reaction. Default units 
are Newtons.

To see the reaction vectors, choose:

Postprocess panel ► Results ► Static ► M Reactions ► 
Vectors

If labels are displayed, four numbers appears. The first three 
are the reaction vector and the last is the module of this vector.
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8. Tutorial 7 - Analysis of a concrete building

This example will consist in the analysis of a simple concrete 
building introducing the concepts of combined load cases and 
the concept of concrete dimensioning.

The geometry corresponding to this tutorial can be found here 
(IGES format):

RamSeries-Tutorials7-concrete_building.igs

Alternativelly, the model ready to be meshed and run, can be 
automatically loaded into the GUI by left-clicking on the button 
below.

Load model

If you prefer to build the model from scratch, the geometry can 
be simply constructed in GiD using the following usefull pre-
processing commands which are described in detail in the GiD 
User's Manual.

Geometry ► Create ► Line

Utilities ► Copy ► Traslation (Do extrude lines)

Geometry ► Create ► NURBS surface ► By contour

View ► Rotate ► Trackball

View ► Render ► Smooth

The final model will be composed of 8 surfaces, 22 lines for the 
supports, 28 lines for the boundary beams, 8 interior help lines 
(not meshed) and all of its connecting . Be careful to position 
the structure related to the global axes as seen in the picture. 
Then, it will be easier to follow the example. The six points that 
define the base projection of the building are the following:

A-> (-5,0,0)
B-> (12,0,0)
C-> (12,5,0)
D-> (5,5,0)
E-> (5,11,0)
F-> (-5,11,0)

As a convenience, it is interesting to subdivide the geometrical 
entities into several layers. This will help to assign the 
properties and to visualize easily the results. 

To transfer geometrical entities to one layer, use button 

entities in the layers window.

8.1. Displacement constraints

Constraints for shells can be either applied to points or lines. In 
this example, the constraints are applied to the 11 points that 
are the base of the supports. These points have prescribed 
both, the displacements and the rotations.

Constraints ► Fixed constraints

Activation Values
X constraint YES X value 0.0
Y constraint YES Y value 0.0
Z constraint YES Z value 0.0
θx constraint YES θx value 0.0
θy constraint YES θy value 0.0
θz constraint YES θz value 0.0

If there were prescribed displacements, signs would be the 
following:

This condition must be assigned to the 11 points that are the 
base of the building. In all cases, the prescribed displacements 
and rotations are zero.

8.2. Shell properties

To assign the section and material properties of an isotropic the 
shell, choose:

Materials and properties ► Shells ► Isotropic shell

-Thickness= 230 mm 

-Material= HA-25 (Its characteristic resistance is 25 
N/mm2)

-E= 27.264e9 N/m2 (Young modulus)

-ν= 0.2 (Poisson coefficient)

-Specific Weight= 25000 N/m3
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Local axes system Default is chosen. Following the criteria 
given before, X’ axe will point towards positive global Y axe. Z’ 
axe will be normal to the elements and Y’ will be contained in 
the plane XZ.

Once the values are filled in, the condition must be assigned to 
the surface that defines the shell.

The conditions that have been assigned can be viewed right-
clicking on the created group: 

Draw ► Draw values / Draw groups / Draw symbols

8.3. Support properties

To assign the beam properties to the support, disconnect all 
layers except the layer called pilares. Then choose:

Materials and properties ► Beams ► Rectangular 
section

The beams will have the following rectangular section 
properties:

-Width Y= 300 mm (width of the rectangular 
section along the Y' direction)

-Width Z= 300 mm (width of the rectangular 
section along the Z' direction)

-Material= HA-25 (Its characteristic resistance is 25 
N/mm2)

-E= 27.264e9 N/m2 (Young modulus)

-ν= 0.2 (Poisson coefficient)

-Specific Weight= 25000 N/m3

-Maximum stress= 25 N/mm2

To assign properties to the beams, it is first necessary to define 
local axes. To this aim, in the present case Automatic local axes 
ares used. Hence, following the standard criteria, X’ axes (prime 
refers to local axes) will remain alligned along the horizontal 
beams longitudinal axis. On the other hand, Y’ will be horizontal 
and perpendicular to the beam longitudinal axis, while Z’ will 
have the same direction and sense than the global Z axis.

Once the values of all rectangular section parameters have been 
provided, the condition must be assigned to all the active 
vertical beams.

When assigning the properties on the vertical beams, the Local 
axes system Automatic is chosen, following the criteria given 
before. In this case the Y’ axe points to the direction of the X 
axe.

The conditions that have been assigned can be viewed right-
clicking on the created group: 

Draw ► Draw values / Draw groups / Draw symbols

8.4. Boundary beams properties

To assign the properties to the boundary beams, disconnect all 
layers except the layer called vigas_de_borde. Then choose:

Materials and properties ► Beams ► Rectangular section

The beams will have the following rectangular section 
properties:

-Width Y= 300 mm (width of the rectangular 
section along the Y' direction)

-Width Z= 400 mm (width of the rectangular 
section along the Z' direction)

-Material= HA-25 (Its characteristic resistance is 25 
N/mm2)

-E= 27.264e9 N/m2 (Young modulus)

-ν= 0.2 (Poisson coefficient)

-Specific Weight= 25000 N/m3

-Maximum stress= 25 N/mm2

To assign properties to the beams, it is first necessary to define 
local axes. To this aim, in the present case Automatic local axes 
ares used. Hence, following the standard criteria, X’ axes (prime 
refers to local axes) will remain alligned along the horizontal 
beams longitudinal axis. On the other hand, Y’ will be horizontal 
and perpendicular to the beam longitudinal axis, while Z’ will 
have the same direction and sense than the global Z axis.

Once the values of all rectangular section parameters have been 
provided, the condition must be assigned to all the active 
horizontal beams.

When assigning the properties on the horizaontal beams, the 
Local axes system Automatic is chosen, following the criteria 
given before. 

The conditions that have been assigned can be viewed right-
clicking on the created group: 

Draw ► Draw values / Draw groups / Draw symbols

8.5. Loadcases
When a new model is created, RamSeries has already defined a 
simple load case. Before applying loads, it is necessary to have 
created the load case where the loads will be included. To 
rename the first load case, choose Rename in the menu 
displayed after doing right-click on

Loadcases ► Loadcase 1

and enter the name 'Peso propio' for the new simple load case.

To create a new load case, select Create new Loadcase in the 
menu displayed after doing right-click on

Loadcases

Enter name 'Sobrecarga' for the created load case.

8.6. Self weight load

As we want this load included in the Peso propio load case, select 
it in the menu defined in the previous section for applying the 
load:

Loadcases ► Peso propio ► Beams ► Self weight

And assign this load to all the supports and boundary beams.
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Then choose:

Loadcases ► Peso propio ► Shells ► Self weight

And assign it to all the surfaces that define the shells.

8.7. Distributed Loads in the shells
As we want this load included in the Sobrecarga load case, select 
it in the menu defined in the previous section for applying the 
load:

Loadcases ► Sobrecarga ► Shells ► Pressure load

The entire shell has a distributed load of 3000 N/m2 along the 
negative global Z-axis:

Factor 1.0
Loadtype Global

X pressure 0.0 [N/m]
Y pressure 0.0 [N/m]
Z pressure -3000.0 [N/m2]

This condition will be assigned to all the surfaces that define the 
shells.

8.8. Combined loadcases
Open the window:

Loadcases ► Combined loadcases

RamSeries will give a different result for every combined load 
case. To change the name of one load case, double click over it 
and write the new name. To add a new combined load case, 
press right button mouse over it and select insert after.

The field ELU is not used for the analysis. It will be used later, 
when dimensioning the steel, to decide if this combined load 
case is used to calculate the section against collapse or against 
service states, like fissuration. Enter the coefficients that will 
amplify the loads. The combined load cases used for this 
problem are:

Combined 
loadcase

Amplification 
factor for Peso 

propio

Amplification 
factor for 

Sobrecarga

Will be used 
for section 

collapse 
checking

Peso propio+s
obrecarga 

servicio

1.0 1.0 NO

Peso propio+s
obrecarga 

último

1.5 1.6 YES

8.9. Mesh generation

When combining beams and shells, option quadratic must be 
deactivated (Meshing>Quadratic elements must be set to Normal
). Triangles are meshed as 3-noded triangles but will be 
calculated internally as 6-noded triangles if problem data option 
is set. It is necessary to obtain good results.

If more elements are used to mesh the geometry, more 
accuracy in the results will be obtained. At the same time, more 
computer time and RAM memory is needed. Use Calculate>View 
process info after doing a preliminary analysis in order to obtain 
information of the memory requirements and the computer 
time needed.

It is also interesting to mesh smaller elements in the zones of 

the shell that will have a bigger gradient in the results.

To estimate the precision of the results related to the number of 
nodes in the mesh, check the test graphics given in the 
appendixes.

To obtain the desired sizes of the elements, use GiD options to 
control the mesh size like:

Meshing ► Assign unstructured sizes ► Points

Meshing ► Assign unstructured sizes ► Lines

Meshing ► Assign unstructured sizes ► By chordal error

Before generating remember to force the meshing of the beam 
boundary lines by choosing:

Meshing ► Mesh criteria ► Mesh ► Lines

To generate the mesh use:

Meshing ► Generate ► 1

In this model, a default size of 1m is chosen for the triangles. 
The total amount of nodes is 381 (1373 after the internal 
conversion to 6-noded triangles).

8.10. Calculate
If the model has not been saved yet, use:

Files ► Save

And give a name to the model.

To begin the analysis choose:

Calculate ► Calculate

The analysis runs as a separate process. Then, it is possible to 
continue working with GiD or exit the program. When the 
analysis is finished, a window will appear notifying it. If it has 
not run successfully, one window showing some error info will 
be supplied. Correct the error and run again.

It is possible to visualize, when the process is running, some 
information about its evolution. Press:

Calculate ► View process info

To get it. One of the most important information that can be 
obtained in this window is the amount of RAM memory, 
expressed in Megabytes, needed by the solver. The total 
amount of memory required by the analysis code if somewhat 
bigger. For skyline solver, the total amount is about 10% more. 
For Sparse solver, it is about the double of memory. This data 
gives an idea of the maximum problem that can be solved in a 
given computer.

This specific analysis needs about 25Mb of memory to execute 
(it should be necessary a RAM of 64Mb or 96Mb to run it 
correctly). Using an Sparse solver, it would need much less 
memory.

8.11. Postprocess

The part of the program dedicated to visualize the results of the 
analysis is called Post-process. Once the calculation is finished, 
to enter in the post-process part and load automatically the 
results select:

Postprocess ► Start

To perform the operation correctly, it is necessary to have the 
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model loaded inside the reprocessing part before going to post-
process.

8.12. Active load case
To select the active load case choose:

Postprocess panel ► Results ► Pp sobrecarga último

or

Postprocess panel ► Results ► Pp sobrecarga servicio

All the results will be displayed for each active load case.

8.13. Deformation of the structure
To visualize the deformed of the structure check:

Postprocess panel ► Results ► Pp sobrecarga servicio ► 
Displacements ► Contour fill

Postprocess panel ► Preferences ► Deformed ► Draw:[Yes]

Postprocess panel ► Preferences ► Deformed ► 
Factor:[200]

Postprocess panel ► Preferences ► Deformed ► 
Result:["Static Displacements"]

The deformed of the structure is drawn magnified in the screen. 
The magnifying factor is automatically calculated if 
"Adimensional factor" option is selected. To change the factor, 
write a new factor and unselect "Adimensional factor" checkbox.

8.14. Contour fill of the displacements

Another way to see the magnitude of the deformation of the 
shell is to use:

Postprocess panel ► Results ► Pp sobrecarga último ► 
Displacements ► Disp z ► Contour fill

To see the numerical values of the deformation choose at any 
point, node or element:

Postprocess ► Mesh information

Try also pressing mouse left button over any structure element 
in the screen.

Make the appropriate zooms to visualize properly the values. 

To switch off the labels press:

Mouse right button ► Label ► Off

In order to choose the visualization style for the shell, try:

Postprocess panel ► Meshes ► Display style

8.15. Momentum reactions
This is the reaction momentum. It is expressed as a vector 
showing the rotation axe and a module that means the rotation 
amount. Default units are N·m.

Postprocess panel ► Results ► Static ► M Reactions ► 
Vectors

8.16. Momentum in Y’ axe
This is the momentum that rotates around the Y’ axe. Default 
units are N·m

Postprocess panel ► Results ► Pp sobrecarga último ► 
Beams ► Y' momentus ► Line diagram
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Sign criteria for momentum in beams is:

Diagram is drawn in the plane X’Z’ and in the side of the beam 
where the traction is. Positive values of the momentum mean 
that traction is in the –Z’ side (in the negative side of Z’).

Other strengths in beams are described in the Analysis of a 
beam structure chapter.

8.17. Reactions
These are the reactions that appear in the constraints. All nodes 
that have no constraint will have a null reaction. Units are N.

If labels are displayed, four numbers appears. The first three 
are the reaction vector and the last is the module of this vector.

To see the colored vectors can be seen with option:

Postprocess panel ► Results ► Static ► M Reactions ► 
Vectors

To see the resulting reactions:

Postprocess ► Compose reactions

8.18. Self defined Contour fill limits for 
strengths

It is quite usual that there are local concentrations of strengths 
near the constraint points or near the nodal forces. In these 
cases, the scale of color has not enough contrast in the rest of 
the shell. To avoid it, it is possible to change the limits of the 
values of the contour fill. The zones of the shell that have values 
higher that the maximum limit or lower that the minimum one, 
will appear either black, transparent or in a defined colour, 
depending on the user preferences.

To define the maximum and minimum limits activate the 
corresponding checkbox, and define the limits:

Postprocess panel ► Results ► Limits

Right-click over the "Limits" label, leads to the following 
available options:

Recalculate limits

Recalculate limits-all steps (only dynamic analyses)

Multiple results

Only active meshes

Legend colours

Redraw

Other strengths in shells are described in the Analysis of a 
shell structure chapter.

8.19. Visualization of strengths in the beams

All of the strengths are represented related to the local axes 
systems of every beam. The visualization is made with a 
diagram that will be more separated from the beam as the 
magnitude of the strength increases. 

Postprocess panel ► Results ► Pp sobrecarga último ► 
Beams ► Max stresses ► Sx ► Line diagram

It will be drawn in either side of the beam depending on the 
sign. 

To see the numerical values of the strengths choose:

Mouse right button ► Label ► All

or 

Postprocess ► Mesh information

To hide the numerical results select:

Mouse right button ► Label ► Off
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8.20. Visualization of strengths in the shell

All of the strengths are represented related to the local axes 
systems of every shell (except the strengths in main axes). The 
visualization will be generally with a Contour Fill of every 
component of the strength although there are other ways to 
visualize them. 

Postprocess panel ► Results ► Pp sobrecarga último ► 
Shells ► Axial force/Shear/Momentus

To see the numerical values of the deformation choose (in the 
menu that appears when pressing the secondary mouse button 
over the screen):

Mouse right button ► Label ► All

Or

Postprocess ► Mesh information

To hide the numerical results select:

Mouse right button ► Label ► Off

The strengths are the following:

Name Units chosen Remarks
Axial force Nx’, Ny’, Nx’y’ kN/m Axial force in 

all the shell 
thickness per 
unit width of 

the shell
Momentum Mx’, My’, Mx’y’ kN·m/m Momentum 

per unit width 
of the shell

Shear Qx’, Qy’ kN/m Shear 
strength per 
unit width of 

the shell

The sign criteria for these strengths is:

Note: See that Mx’ momentum is contained inside plane X’Z’. 
This criteria is different from the strength criteria in beams or in 
constraints, where the rotation in X’ is the one that rotates 
around X’ axe. The rotation axe criteria for shell momentum are 
inherited from the plate criteria. In that case, as there are only 
two rotations in a plate, this choosing looked appropriate. For 
rotations in 3D, as there are 3, it is necessary to use the other 
criteria.

As a example, this is the Mx’momentum on the shells:

8.21. Visualization of the shells Local axes
To see the local axes for Shells, choose:

Postprocess panel ► Results ► Pp sobrecarga último ► 
Shells ► Local axes ► Local axes
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Local X’ axe is drawn in color blue, Y’ axe in red and Z’ axe in 
green.

If they are different than supposed, go to the pre-processing 
part, change the properties accordingly and calculate again.

9. Tutorial 8 - Elastoplastic analysis of a deep 
beam
Next example shows the elastoplastic analysis of a deep beam. 
Geometric and mechanic characteristics are shown below.

The geometry corresponding to this tutorial can be found here 
(IGES format):

RamSeries-Tutorials4-dynamic_beams_and_shells.igs

Alternativelly, the model ready to be meshed and run, can be 
automatically loaded into the GUI by left-clicking on the button 
below.

Load model

9.1. Analysis Data

The required information for the elastoplastic analysis can be 
defined in the analysis options:

General data ► Analysis

Analysis type Incremental loads analysis

Material Constitutive model Plasticity on materials

General data ► Non-linear analysis data ► General

Use default data

General data ► Non-linear analysis data ► Advanced

Use deafult data

General data ► Incremental analysis data

Num increments 10

9.2. Displacement constraints

Constraints for shells can be either applied to points or lines. In 
this example, the constraints are applied to 2 segments of the 
bottom boundary of the shell.

Constraints ► Fixed constraints

Segments AB and CD are completely restrained:

Activation Values
X constraint YES X value 0.0
Y constraint YES Y value 0.0
Z constraint YES Z value 0.0
θx constraint YES θx value 0.0
θy constraint YES θy value 0.0
θz constraint YES θz value 0.0

In this condition, the local axes have no relationship with the 
shell local axes defined in the properties section. The GLOBAL 
option means to prescribe related to the global axes of the 
problem. This is used in this case. Local axes are used to 
prescribe the displacement or rotation in a direction not 
coincident with any of the global axes. The values part of the 
condition is used to prescribe a fixed amount of displacement 
or rotation. Default units are meters for the X, Y and Z 
displacements and radians for the prescribed rotations. In this 
case, the prescribed displacements and rotations are all zero.

X Constraint, Y Constraint and Z Constraint mean the 
displacements along the axes. Theta x Constraint, theta y 
constraints and theta z constraints mean the rotations around 
the axes. Signs are as follows (right hand rule):
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This condition must be assigned to the lines described in the 
picture. The prescribed displacements and rotations are zero.

9.3. Static load
The top face of the beam carries a distributed load of 400e3 
N/m along the negative global Y-axis. Therefore, the setting 
Contour pressure will be used.

Loadcases ► Loadcase 1 ► Shells ► Boundary pressure load

Factor 1.0
Loadtype Global

X pressure 0.0 [N/m]
Y pressure -400e3 [N/m]
Z pressure 0.0 [N/m]

9.4. Materials
The following elastoplastic properties of the material of the 
beam will be assigned,

Materials and properties ► Shells ► Plasticity shell

-Thickness= 0.01 m 

-Material= Steel A52 P

-Num layers= 10

Such material Steel A52 P has the following properties:

-E= 1.1e11 N/m2

-G=4.6e10 N/m2

-v=0.2

-Specific weight= 42112 N/m3

-Maximum stress= 0.0 N/m2 (not accounted for in 
the calculation)

-Constitutive model= J2_plasticity

-Tensile Yield Stress=150.0e6 N/m2

-Isotropic hardening= None

-Kinematic hardening= None

9.5. Results
The following pictures show some results for the performed 
analysis:

Postprocess panel ► Preferences ► Deformed ► Draw:[Yes]

Postprocess panel ► Preferences ► Deformed ► 
Factor:[200]

Postprocess panel ► Preferences ► Deformed ► 
Result:["Static Displacements"]

Deformed

Postprocess panel ► Results ► Static ► Shells ► Axial force 
► Main stresses

Main axial force

Postprocess panel ► Results ► Static ► Shells ► Von mises 
top ► Contour fill
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Von Mises stress Top [MPa]
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10. Tutorial 9 - Analysis of a laminated 
composite shell

Introducion

The application of laminated composite materials in various 
engineering areas (from aeronautics to naval and civil 
engineering applications) is continuously increasing over the 
years. These laminated materials are mainly used in the form of 
shells and plates and also thin-walled beams built as an 
assembly of flat panels. In this tutorial, a very simple laminated 
shell clamped at the end edges and subjected to its self-weight 
is analyzed.

In this case, the analysis is performed using the classical 
lamination theory (CLT) constitutive model. Aternatively, the 
more sofisticated heterogeneous and serial/parallel rule of 
mixture (RoM) models are also available in RamSeries to 
undertake for instance non-linear analysis of composite 
structures.

Model definition

The model geometry is shown in Figure 1. It includes a shell of 
dimensions 1x1 meter. The shell is actually divided into two 
halfs, each one corresponding to a different laminated 
composite material. Laminate 1 has a total thickness t1 = 9.38 
mm., while laminate 2 has a total thickness t2 = 13.73 mm.

Fig.1. Laminated composite shell geometry

The geometry corresponding to this tutorial can be found here 
(IGES format):

RamSeries-Tutorials9-laminate_shell.igs

Alternativelly, the model ready to be meshed and run, can be 
automatically loaded into the GUI by left-clicking on the button 
below.

Load model

Modelling instructions

If this is prefered, the model can be built from scratch. To this 
aim, the geometry can be simply constructed in GiD using the 
following usefull pre-processing commands which are described 
in detail in the GiD User's Manual.

Geometry ► Create ► Object ► Rectangle

1.- In the command line enter the coordinates (0.0, 0.0, 0.0) of 
one of the vertices of the shell and press the <Enter> key.

2.- In the command line enter the coordinates (1.0, 0.25, 0.0) of 

the opposite vertex of the first quarter of the shell and press the 
<Enter> key.

Utilities ► Copy (surfaces) ► Traslation (Multiple copies: 3)

1.- In the Copy window select the Surfaces entity type.

2.- Select the Translation transformation.

3.- Keep the coordinates (0.0, 0.0, 0.0) for the First point of the 
transformation.

4.- Introduce the coordinates (0.0, 0.25, 0.0) for the Second point 
of the transformation.

5.- Check the Collapse checkbox to ensure coincident lines and 
not duplicated after applying the transformation.

6.- Select No in the Do extrude option.

7.- Check the Maintain layers checkbox to ensure, for 
convinience, that all the new geometrical entities created during 
the transformation are located in the same original layer.

8.- In the Copy window click the Select button and proceed to 
select the previously created rectangular surface. Finish the 
copy operation by pressing the <Escape> key.

As a result, you should obtain two adjacent rectangles 
representing half of the 1x1 m. shell. Repeat the Copy 
tansformation operation by selecting both surfaces and 
applying a 0.5 meters translation in the Y direction. Yo should 
finally obtain the complete 1x1 shell divided for convinience into 
4 equally sized parts. The final geometry of the model is hence 
composed by 4 rectangular surfaces, 13 lines and all the 
corresponding connection points.

10.1. Analysis data

In order to undertake the analysis of a composite material 
structure, it is necessary to explicitly activate the 
'Laminate/Composite material' feature in RamSeries. This is 
done in the 'Analysis' section of the data tree:

General data ► Analysis

Use Laminate/Composite 
materials Yes

By doing this, composite materials become available in the 
'Materials and properties' section of the data tree. Specific 
composite results become available as well, so that failure index 
(FI) and reserve factor (RF) results can be specified to be 
computed at run time.

General data ► Results ► Composite sec. factor

Output composite results Yes
Full Tsai-Wu FI Yes
Tsai-Wu RF Yes

10.2. Displacement constraints

The laminated shell under analysis is clamped by its two end 
edges. Hence, constraints must be applied to the lines 
corresponding to these edges, AB and CD segments in the 
figure below.

Constraints ► Fixed constraints
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DOF Constrained Values
X YES 0.0
Y YES 0.0
Z YES 0.0
θx YES 0.0
θy YES 0.0
θz YES 0.0

In this case, the constraints are applied in the global reference 
system and all displacements and rotations are fixed to zero. 
Local axes can be used if necessary to prescribe the 
displacements and/or rotations in a direction not coincident 
with any of the global axes.

10.3. Shell properties

The shell under analysis consists in two laminated composites 
joined together. Hence, two different laminate materials must 
be created in RamSeries. To this aim, the unitary composite 
materials need to be defined first. Nevertheless, few composite 
materials are already included by default in the RamSeries' 
materials library. In particular, IM6-Carb_Epoxy and E-
Glass_Epoxy composite materials are available and will be used 
to build the laminates for the present tutorial. Laminate 
characteristics, such as the number of layers, the material of 
each layer(or set of layers) the fibrer angle within each layer and 
the corresponding stacking sequence, must be specified for the 
definition of a given laminate. The first laminate in this tutorial 
consists on a 4 x [45,-45]s sequence of IM6-Carb_Epoxy. This 
results in a laminate with 16 layers for a total thickness t = 
0.009378 m. The second laminate consists on a 10 x [0,45,-45] 
sequence of E-Glass_Epoxy that results in a laminate with 30 
layers and a total thickness t = 0.013728 m. Each laminate 
description can description can be found in the figure below.

Laminate 1 definition: 4 x [45,-45]s sequence of IM6-Carb_Epoxy

Laminate 2 definition: 10 x [0,45,-45] sequence of E-Glass_Epoxy

Once the various laminates have been defined, the actual 
material properties can be assigned to the different parts of the 
shell.

Materials and properties ► Shells ► Laminate shell

In this case, laminate 1 is assigned to half of the shell and 
laminate 2 is assigned to the other half. This implies the creation 
of two material groups that are assigned to the geometry as 
shown in the figure below:

Material properties assigned to the laminated shell. The yellow region of the shell has 
assigned laminate 1 material properties while the green region has assigned laminate 2 

properties.

10.4. Distributed loads
The shell under analysis is subjected only to its own self-weigth. 
Self-weight condition can be simply applied in RamSeries using 
the following option that must be applied to the entire 
geometry.

Loadcases ► Loadcase 1 ► Shells ► Self weight load

10.5. Mesh generation

Shells can be meshed in RamSeries using triangular and 
quadrilateral elements. In both cases linear and quadratic 
element formulations are also available. In this case, the shell is 
meshed using linear triangles with a maximum element size h = 
0.05. It results in a mesh with 748 tringualar elements and 415 
nodes.
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10.6. PostProcess
The part of the program dedicated to visualize the results of the 
analysis is called Post-process. Once the calculation is finished, 
load the post-process by using the following option:

Postprocess ► Start

To perform the operation correctly, it is necessary to have the 
model loaded inside the pre-processing part before going to 
post-process. Choose the view style Body bound if it is not still 
selected. With this type of view, contour fill results on shells are 
visualized better. 

10.6.1. Deformation of the structure
To visualize the deformed mesh of the structure check the 
following options within the preferences panel of the post-
process data tree:

Postprocess panel ► Preferences ► Deformed ► Draw:[Yes]

Postprocess panel ► Preferences ► Deformed ► 
Factor:[1.0e3]

Postprocess panel ► Preferences ► Deformed ► 
Result:["Static Displacements"]

The deformation of the structure is drawn magnified in the 
screen. The magnifying factor is automatically calculated if 
"Adimensional factor" option is selected. To change the factor, 
write a new factor and unselect "Adimensional factor" checkbox.

10.6.2. Contour fill of the displacements

Another way to see the magnitude of the deformation of the 
shell is to use the displacements countour fill result.

Postprocess panel ► Results ► Static ► Displacements ► 
Disp z ► Contour fill

To see the numerical values of the deformation at any point, 
node or element use the following option:

Postprocess ► Mesh information

Try also pressing the mouse left button over any point in the 
screen. Make the appropriate zooms to visualize properly the 
values.

To switch off the labels press:

Mouse right button ► Label ► Off

In order to choose the visualization style for the shell, try:

Postprocess panel ► Meshes ► Display style

10.6.3. Visualization of strengths

All of the strengths are represented related to the local axes 
systems of every shell (except the strengths in main axes). The 
visualization will be generally with a Contour Fill of every 
component of the strength although there are other ways to 
visualize them. To see the numerical value of the strength that is 
being visualized, choose:

Mouse right button ► Label ► All

To hide the numerical results select:
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Mouse right button ► Label ► Off

Both commands can be found in the menu that appears when 
pressing the secondary mouse button over the screen. The 
strengths are the following:

Name Default units Remarks
Axial force Nx’, Ny’, Nxy' N/m Axial force in 

all the shell 
thickness per 
unit width of 

the shell
Momentum Mx’, My’, Mx’y’ N·m/m Momentum 

per unit 
width of the 

shell
Shear Qx’, Qy’ N/m Shear 

strength per 
unit width of 

the shell

Note: See that Mx’ momentum is contained inside plane X’Z’. 
This criteria is different from the strength criteria in beams or in 
constraints, where the rotation in X’ is the one that rotates 
around X’ axe. The rotation axe criteria for shell momentum are 
inherited from the plate criteria. In that case, as there are only 
two rotations in a plate, this choosing looked appropriate. For 
rotations in 3D, as there are 3, it is necessary to use the other 
criteria. As an example, the Mx’ momentum on the shell is 
shown in the figure below:

Postprocess panel ► Results ► Static ► Shells ► Momentus 
► Mx ► Contour fill

10.6.4. Visualization of Security factors

If the user needs to visualize the different results (stress, strain, 
shear strain, shear stress or security coefs.) among each 
individual layer of the laminate, a specific tool exists in the post-
process of RamSeries:

Postprocess ► Laminates

In the displayed window, choose the desired layer and result to 
be viewed. It is also possible to visualize the results for the last 
layer of all the existing laminates in the analysis, for all 
laminates need not have the same number of total layers. So, if 
an user selects the last layer of one of the laminates and one or 
various of the others have less layers, only the results for this 
selected laminate will be displayed. Using the option "Last layer", 
results for the last layer of each of the laminates will be 
displayed. In addition, the user could see the results for the rest 
of layers counting down from the last of every laminate, by 
means of clicking on the '+' or the '-' button.

The security factors, (Tsai-Wu or LaRC04 criteria) can be 
visualized for the global laminate or for each layer separately, 
providing maximum stresses values have been inserted in the 
material definition.

Also, it is necessary to have choosed to output this security 
factors results, and select which one of them is to be actually 
output.

Tsai-Wu criteria:

Security factor following complete Tsai-Wu criteria can be 
visualized, either for every single layer using the specific 
laminates tool: 
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Postprocess ► Laminates

Or for the complete layer:

LaRC04 criteria (NASA):

Security factors following LaRC04 criteria can be also visualized 
(Ref. [10]). This criteria includes six different failure modes for 
matrix and reinforcement.

Visualization of security factors can also be done for the full 
composite, or for each layer separately.
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11. Tutorial 10 - Non-Linear Analysis with 
SeaFEM Loads
This tutorial is a simple analysis produced in order to show 
RamSeries Non-Linear (geometric) dynamic capabilities, 
combined with wave pressure loads coming from previously 
performed SeaFEM simulations.

For running this analysis, it is necessary to have previously run 
the correspondent SeaFEM analysis, which results will be the 
loads (wave pressure loads) for RamSeries model. Though some 
description of SeaFEM model will be showed in this tutorial, 
please refer to the section "Application example" in SeaFEM 
reference manual (Help>Help Seakeeping or 
http://www.compassis.com/downloads/Manuals/SeaFEMManua
l.pdf) for details on the set-up of the simulation.

The geometries corresponding to this tutorial can be found 
here (IGES format):

RamSeries-Tutorials10-SeaFEM_loads_nonlinear_Ram.igs

RamSeries-Tutorials10-SeaFEM_loads_nonlinear_Sea.igs

Alternativelly, the model ready to be meshed and run, can be 
automatically loaded into the GUI by left-clicking on the button 
below.

Load model

The model has a simple geometry, consisting on a cylinder, with 
the following dimensions:

Rcyl = 1.0 m

hcyl = 0.7 m

http://www.compassis.com/downloads/Manuals/SeaFEMManual.pdf
http://www.compassis.com/downloads/Manuals/SeaFEMManual.pdf
http://www.compassis.com/downloads/Manuals/SeaFEMManual.pdf
http://www.compassis.com/downloads/Manuals/SeaFEMManual.pdf
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11.1. Analysis Data

In order to be able to perform this analysis, the user must select 
the following simulation options:

General data ► Analysis ► Element types: Shells

General data ► Analysis ► Analysis type: Dynamic analysis

General data ► Analysis ► Geometric constitutive model: 
Non-Linear geometry

The following dynamic analysis parameters are chosen:

General data ► Dynamic analysis data ► General

Type Direct integration
Δt 0.1 s

Number of steps 600

General data ► Dynamic analysis data ► Integration data

Integration method Implicit (Energy 
Conserving/Decaying)

αE-C/D 0.0

General data ► Dynamic analysis data ► Damping data

Damping type Rayleigh
αK 0.0
αM 0.4415

The damping coefficient has been calculated as the 5% of the 
critical damping, as showed next:

ξ=C/Cc=1

with:

C=M·α'M

Cc=2·M·ωc

So: 

α'M = 2·ωc

The frequency is calculated as:

ωc = √(K33/M) = 4.415 s-1

with:

K33 = ρ·g·Aflot = 31557.3 N/m

M: Total mass of the floater

In this case: αM = 0.05·(2·ωc) = 0.05·α'M = 0.04415
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11.2. Constraints
Constraints ► Fixed constraints

The model has its displacement restrained in the direction 
transversal to the advancing direction of the wave system (Y 
axis). This condition is applied to the points A(0.0,-1.0,-0.5) and 
B(0.0,1.0,-0.5), together with a restriction in the X axis rotation 
(to prevent the model from having a roll movement, and make it 
coherent with SeaFEM model).

Activation Values
X constraint NO X value 0.0
Y constraint YES Y value 0.0
Z constraint NO Z value 0.0
θx constraint YES θx value 0.0
θy constraint NO θy value 0.0
θz constraint NO θz value 0.0

Also points C(-1.0,0.0,-0.5) and D(1.0,0.0,-0.5) have restrained the 
displacement in the Y axis direction, in order to prevent the 
rotation in the Z axis (yaw movement), and be coherent with the 
SeaFEM model.

Activation Values
X constraint NO X value 0.0
Y constraint YES Y value 0.0
Z constraint NO Z value 0.0
θx constraint NO θx value 0.0
θy constraint NO θy value 0.0
θz constraint NO θz value 0.0

Constraints ► Elastic constraints

Also, an elastic constraint has been applied at the point A(-
1.0,0.0,-0.5). The stiffness value is K=100 N/m. This condition is 
also applied in the SeaFEM model, to make them equivalent. 

Activation Values

X constraint YES X value 100.0 
N/m

Y constraint NO Y value 0.0
Z constraint NO Z value 0.0
θx constraint NO θx value 0.0
θy constraint NO θy value 0.0
θz constraint NO θz value 0.0
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11.3. Material properties

The shells are assigned with a material of the following 
properties (the material is assumed to be isotropic and linear 
elastic). To assign the section and material properties of an 
isotropic the shell, choose:

Materials and properties ► Shells ► Isotropic shell

-Thickness= 0.1 m 

-E= 2.1e11 N/m2 (Young modulus)

-ν= 0.3 (Poisson coefficient)

-Specific Weight= 20821 N/m3

Local axes system Default is chosen. Following the criteria 
given before, X’ axe will point towards positive global Y axe. Z’ 
axe will be normal to the elements and Y’ will be contained in 
the plane XZ.

Once the values are filled in, the condition must be assigned to 
the surface that defines the shell.

The conditions that have been assigned can be viewed right-
clicking on the created group: 

Draw ► Draw values / Draw groups / Draw symbols

The hidrostatic equilibrium is previously stablished, by checking 
de displacement calculated in SeaFEM, and the reactions in 
RamSeries due to the self-weight load.

Therefore, the specific weight (ρ) has been adjusted so the 
cylinder has its floating line in z = 0 (this means a depth of d=0.5 
m). 

Displacement (SeaFEM): ΔSF = 15689.31 N

Cylinder area: Scyl = 7.535 m2

ρcyl = ΔSF/(Scyl·tcyl) = 20821 N/m3

Reactions (RamSeries, self-weight): Rsw = 15643.3 N

Reactions (RamSeries, hidrost.): Rhyd = 15689.3 N

*Note: An slight difference between weight and lift exists and it 
is assumed (0.3%).
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11.4. Loads
The model is loaded with the dynamic pressures coming from 
the SeaFEM analysis results:

Loads ► Loadcase 1 ► Shells ► Seakeeping wave load

The file with the corresponding SeaFEM model results must be 
selected.

This load is applied in the same sense and direction of the 
normal to the surface, so it must be checked that the normals 
points towards the inside of the cylinder. Seakeeping Wave 
Loads are applied to the surfaces below the floating line (Z = 0).

The previously described load reads and applies only the 
dynamic part of the wave pressure coming from SeaFEM result 
files. Therefore the hydrostatic pressure load is needed to be 
applied:

Loadcases ► Loadcase 1 ► Shells ► Pressure load

Factor Click Function icon to insert the 
following info:
Function on geometry 
(Hydrostatic load)
Reference coordinate = 0.0
Water specific weight =-
10045.0 N/m3

Note that for the water specific weight, the same density as in 
SeaFEM has been applied (density corresponding to sea water, 
1025 kg/m3). This load is applied to the same surfaces as the 
Seakeeping load, and also to the surfaces above the water 
line, to account for the hydrostatic pressure acting on the 
geometry when it sinks below Z=0. Also note that a negative 
signed has been included in the specific weight due to the fact 
that hydrostatic loads in RamSeries Non-linear geometry 
analysis are applied in the opposite sense to the normal to the 
surface.

The load corresponding to the self-weight of the structure is 
also applied, to all the model surfaces, so the forces are 
equlibrated.

Loads ► Loadcase 1 ► Shells ► Self weight load
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11.5. SeaFEM model
The geometry of the model for SeaFEM is the same, but for the 
part of the cylinder over the free surface (Z= 0), which is 
neglected. So:

Rcyl = 1.0 m

hcyl = 0.5 m

Enviroment data.
The simulation is performed for a monochromatic wave 
system in the X axis direction (0.0 deg), with the following 
parameters:

Awave = 0.1 m

Twave = 6.0 s

Body data:

The body properties (center of gravity and radii of gyration) 
have been set after obtaining them with the tools available 
in RamSeries, whose output is shown in what follows:

Calculating Center of Gravity and Inertia Momentum....

(*Note: Results are given in model length units [Geometry units])

Center of Gravity [L]

(xG,yG,zG) = (-1.83949e-007,-2.6283e-011,-0.295692) [L]

Total weight = 15680 [N]

Moments of Inercia respect to ortogonal axis passing through the 
Center of Gravity 

(Ixg,Iyg,Izg) = (7112.24,7110.87,12476.4) [F*L^2]

Radii of gyration respect to ortogonal axis passing through the 
Center of Gravityn 

(rxg,ryg,rzg) = (0.673488,0.673423,0.892014) [F*L^2]

Moments of Inercia respect to ortogonal axis passing through the 
origin )

(Ixo,Iyo,Izo) = (8483.2,8481.84,12476.4) [F*L^2]

Total time = 0.018 min. = 1.1 seg.

The object has its center of gravity set to CDG=(0.0,0.0,-
0.295).

Only heave, surge and pitch degrees of movement are left free.

External forces have been added:

Elastic spring (same as in RamSeries):

Fx = -100*dx[-1.0,0.0,-0.5]

2. Compensating pitch moment:

This moment is applied so it 
compensates the moment which will 
appear in RamSeries due to the elastic 
restriction.

My = -100*dx[-1.0,0.0,-0.5]*(0.5-0.295)

Irregular frequency removal = 0.05.

A 5% of the critical damping factor has been considered 
here, in order to make the analysis equivalent to the 
RamSeries one.
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11.6. Mesh
An unstructured mesh of linear triangles has been used.

Mesh ► Generate mesh ► [Maximum element size]=0.2
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11.7. Results
The main goal of this tutorial analysis is to validate that the 
dynamics of RamSeries follows the dynamic imposed by the 
pressure results obtained in SeaFEM. 

The following images show the comparison of both codes 
solution for the main movements: heave, surge and pitch. Pitch 
movement is compared verifying that two points, at bow and 
stern ([1,0,-0.5] and [-1,0,-0.5]), have the same heave movement 
for both codes solution.

The coincidence of both signals grant that the pitch motion 
(rotation around the Y axis) is also coincident.

Heave movement of a point located at stern:

Heave movement of a point located at bow:

Surge movement of center of gravity (0,0,-0.296):

For this movement, an small offset appears in the amplitude of 
the signals. This is produced by the initial transitory which is not 
exactly the same in both simulations.

Nevertheless, it is very important to remark that both 
signals follow the two main movements periods:

Tw = 5 s (wave period)

Tk = 25.33 s (spring natural period)

The spring period is calculated as follows 
(it includes the critical damping 
percentage inserted in RamSeries model):

ωK = √(K/M - (ξ/2)2)

TK = 1/ωK

Being M the total floater mass, K=100 N/m 
the spring constant, and ξ = 0.05 (5%) the 
percentage of the critical damping 
considered.
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11.7.1. Linear results
A linear analysis has also been performed, in order to compare 
results. If small movements are expected, it may be quite 
convenient and advisable to perform a linear analysis instead of 
the non-linear, for it runs faster.

The obtained signal for heave is very similar, but for the initial 
transitory (showed in the following image):

12. Tutorial 11 - Contacts analysis

The example is used to describe the contact analysis will be a 
cylinder on cylinder Hertzian contact problem.

The geometry corresponding to this tutorial can be found here 
(IGES format):

RamSeries-Tutorials11-solids_contact.igs

Alternativelly, the model ready to be meshed and run, can be 
automatically loaded into the GUI by left-clicking on the button 
below.

Load model

12.1. Analysis data

General data ► Analysis ► Element types: Solids

General data ► Analysis ► Analysis type: Incremental loads 
analysis

General data ► Analysis ► Material constitutive model: 
Plasticity on materials

The following dynamic analysis parameters are chosen:

General data ► Non-linear analysis data ► General

Solver control Load control
Conv. tolerance 1.0e-4
Iteration type Full Newton-Raphson
Max iterations 40

General data ► Incremental analysis data

Num increments 10
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12.2. Constraints
Constraints ► Fixed constraints

The bottom surface has a prescription in its movements in the 
three global directions X, Y and Z.

Activation Values
X constraint YES X value 0.0
Y constraint YES Y value 0.0
Z constraint YES Z value 0.0

For applying symmetry to the model, the following constraints 
must be defined. Slave nodes cannot have fix constraints, so 
elastic constraints must be used instead of fix constraints. If 
stiffness of elastic constraints is thousand times greater than 
materials´ stiffness, elastic constraint works better than a fix 
constraint:

Constraints ► Elastic constraints

Constraint in plane X=0:

Activation Values
X 

constraint YES X value 2.0e5 
N/mm3

Y 
constraint NO Y value 0.0

Z 
constraint NO Z value 0.0

Constraint in planes Z=0 and Z=2:

Activatio
n Values

X 
constraint NO X value 0.0

Y 
constraint NO Y value 0.0

Z 
constraint

YES Z value 2.0e5 
N/m
m3

Constraint in lines Z=0/X=0 and Z=2/X=0:

Activatio
n Values

X 
constraint

YES X value 2.0e5 
N/m
m2

Y 
constraint NO Y value 0.0

Z 
constraint

YES Z value 2.0e5 
N/m
m2
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12.3. Contacts definition
For defining contacts, it is necessary to select which surfaces are 
master and which are slave. Type of contact must also be 
chosen.

Contacts ► Contacts structural ► Master-Slave Surf-Surf

It is recommended to rename master ans slave groups to make 
easy to identify them in Groups window .

Data ► Groups

There is not a fix rule about which surface must be master and 
which must be slave. However, it is advisable to choose the 
more rigid as master surface. On the other hand, stresses in 
slave surface will be more accurate than in master slave, so, it is 
a good option to choose as slave the surface where a better 
accuracy is requested.
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12.4. Material properties and loads definition

The solids are assigned with a material of the following 
properties (the material is assumed to be isotropic and linear 
elastic). To assign the section and material properties of an 
isotropic solid, choose:

Materials and properties ► Solids ► Isotropic solid

-Thickness= 0.1 m 

-E= 200 N/mm2 (Young modulus)

-ν= 0.3 (Poisson coefficient)

-Specific Weight= 0.0 N/mm3

Once the values are filled in, the condition must be assigned to 
the volumes which defines the solid.

The two volumes corresponding to the master and the slave 
solids are each one assigned with a different material group, 
though both have the same properties.

The conditions that have been assigned can be viewed right-
clicking on the created group: 

Draw ► Draw values / Draw groups / Draw symbols
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12.5. Mesh generation

For improving stress accuracy in contacts elements, it is 
recommended to use more elements in slave surface than in 
master surface. Doing so, every master element will have more 
than one slave node in contact.

In this example, a structured mesh is used and master and slave 
mesh are equal, so stress results will be very accurate.

Use the following Gid options to get a structural mesh:

Mesh ► Structured ► Volumes ► Assign number of cells
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12.6. Results
The following pictures show results for the defined analysis:
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13. Tutorial 12 - Full Body Coupling with SeaFEM

This example is used for describing the coupled analysis with 
SeaFEM (seakeeping analyses) and RamSeries (structural 
analyses). This coupling can be of two types: 

3. . HFS (Height Free Surface), which is performed via an 
special free surface pressure condition.

4. . Body, this is the case showed in this tutorial. The coupling 
is performed using the mesh of the floating body.

The geometry corresponding to this tutorial can be found here 
(IGES format):

RamSeries-Tutorials12-coupling_SeaFEM_RamSeries.igs

Alternativelly, the model ready to be meshed and run, can be 
automatically loaded into the GUI by left-clicking on the button 
below.

Load model
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13.1. Loading the coupled analysis

To load the RamSeries type of analysis, choose:

Simulation Type ► Coupled Seakeeping-Structural Analysis

For this kind of problem, the analysis can be set up from the 
Start Data window, as shown in the Beams tutorial, with the 
following options in this case:

Data ► Start data

- Simulation dimension: 3D

- Structural analysis: Shells

- Analysis type: Dynamic: Direct 
integration analysis

- Material constitutive model: Linear 
materials

- Geometrical constitutive model: Non-
Linear geometry

- Analysis domain: (Time) First order 
diffraction radiation

- Environment: Waves

- Type of analysis: Seakeeping

Also from the data tree in the GUI: 

Simulation data ► Simulation type

13.2. Geometry generation

The first step is to create the geometry. It can be defined using 
the pre-processing commands described in the GiD manual. It is 
important to take in consideration that both geometries for 
RamSeries and SeaFEM models must be generated. Some parts 
of the geometry will need to be duplicated in the coincident 
zones, therefore, it is more than advisable to have a good layer 
organization for the geometry.

So, the first step is to open the layers window and create the 
layers to be used:

Utilities ► Layers

RamSeries geometry creation

In this case, the geometry for RamSeries is very simple: it 
consists in a rectangular barge of 20 m length, 5 m beam and 
3.0 m height.

5. Open the layers window and create the layer called 
RamSeries>Hull: 

6.  Create the base rectangle:

Geometry ► Object ► Rectangle ► Corner 1: (-10,-2.5,-1.0) ► 
Corner 2: (10,2.5,-1.0)

7.  Extrude de contour lines of the rectangle to create the 
barge:

First up to the free surface:

Utilities ► Copy, Lines ► Traslation, Extrude: Surfaces ► P1: 
(10,2.5,-1.0), P2: (10,2.5,0.0)

and finally up to complete the total height of the barge:

Utilities ► Copy, Lines ► Traslation, Extrude: Surfaces ► P1: 
(10,2.5,0.0), P2: (10,2.5,2.0)

SeaFEM geometry creation

The dimensions are the following:

Body (wet part of the barge):
Lb = 10 m

Bb = 5 m

db = 1.0 m

Domain cylinder:

For the cases when no currents are imposed, like this, the most 
indicated shape for computational domain is a cylinder. 

Computational depth should be no larger than physical depth. 
Moreover, computational depth might be smaller than physical 
and/or recommended if the bottom boundary condition is used. 
The dimensions for the domain in this case are:

Hd = 20 m

Rd = 50 m

Analysis area cylinder:

A zone with more mesh definition is needed around the floating 
object, in order to correctly capture the scattered waves (waves 
radiated and difracted by the floating object). Moreover, as 
explained before, the border of this area will indicate the start 
of the damping/absorption area (beach). The absorption area 
should be at least as long as the maximum wave length. 
Recommended length is twice the maximum wave length. 
Nevertheless, if monochromatic wave is used along with 
Sommerfeld radiation condition, the absorption area might be 
reduced to half the wave length. 

Therefore, the dimension chosen is:

Haa = 10 m

Raa = 20 m

All geometries for computational domains in SeaFEM must be 
located in Z ≤ 0. In this case it is also centered in the origin 
(0,0,0). A separated layer can be created for the body, some 
more for the free surface, analysis area, external contours of 
the domain, and finally, another for the domain volumes.
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In the following steps, one of the several ways for generating 
the geometry will be explained in detail:

1. Open the layers window and create the layer called 
SeaFEM>cyl_ext: 

Utilities ► Layers

Right click on the layers window + New layer

Create a circle for the base: 

Geometry ► Create ► Object ► Circle

Enter center: 0 0 -20

Enter normal: Positive Z

Enter radius: 50.0

2. Create a new layer called SeaFEM>cyl_int.

Create another circle for the base of the analysis area

Enter center: 0 0 -10

Enter normal: Positive Z

Enter radius: 20.0

3. Create a new layer called SeaFEM>Body_hull.

Create a rectangle for the base of the body.

Geometry ► Object ► Rectangle ► Corner 1: (-10,-2.5,-1.0) ► 
Corner 2: (10,2.5,-1.0)

Extrude de contour lines of the rectangle to create 
the barge:

Utilities ► Copy, Lines ► Traslation, Extrude: Surfaces ► P1: 
(10,2.5,-1.0), P2: (10,2.5,0.0)

4. Copy lines in SeaFEM>cyl_ext creating the surfaces by 
extrusion in the same operation:

Utilities ► Copy, Lines ► Traslation, Extrude: Surface ► P1: 
(50,0,-20), P2: (50,0,0)

5. Repeat the operation for SeaFEM>cyl_int:

Utilities ► Copy, Lines ► Traslation, Extrude: Surface ► P1: 
(20,0,-10), P2: (20,0,0)

Up to this point, the geometry should look as in the following 
image:

6. Create a new layer called SeaFEM>free_surface_ext

Create a surface using the circumferencial contour 
with radius 50 m, at z=0:

Geometry ► Create ► NURBS surface ► By contour

7. Create a hole in the previously created surface:

Geometry ► Edit ► Hole NURBS surface

Enter surface: Select surface at to z=0 
created in the previous step.

Enter lines to define the hole: Select lines of 
the analysis area at z=0.

8. Create a new layer called SeaFEM>free_surface_int

Create a surface using the circumferencial contour 
with radius 20 m, at z=0:

Geometry ► Create ► NURBS surface ► By contour

9. Create a hole in the previously created surface:

Geometry ► Edit ► Hole NURBS surface

Enter surface: Select surface at to z=0 
created in the previous step.

Enter lines to define the hole: Select lines of 
the barge at z=0.

8. Create a new layer called SeaFEM>vol_int

Create a new volume for the inner part of the 
domain:

Geometry ► Create ► Volume ► By contour

Select the surfaces in SeaFEM>cyl_int, 
SeaFEM>free_surface_int and 
SeaFEM>body_hull.
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9. Create a new layer called SeaFEM>vol_ext

Create a new volume for the outer part of the 
domain:

Geometry ► Create ► Volume ► By contour

Select the surfaces in SeaFEM>cyl_ext and 
SeaFEM>free_surface_ext and 
SeaFEM>cyl_int.

The final geometry should look as in the next image:
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13.3. Coupling data

First of all, for performing this ananlysis the correct simulation 
type must be selected:

Simulation data ► Simulation type: Coupled Seakeeping-
Structural analysis

To edit the data regarding to the coupling of both structural and 
seakeeping analysis, please go to the Data tree corresponding 
area:

Simulation data ► Coupling data

Δt 0.1
Number of steps 200

Max FSI iterations 20
FSI tolerance 1.0e-2

FSI relaxation factor 0.25
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13.4. Seakeeping data

The following pages explain how to set the data corresponding 
to the seakeeping part of the analysis.

13.4.1. General data
The seakeeping analysis general data can be edited at:

Seakeeping data ► General data

The seakeeping problem setup is performed editing the 
following fields:

Seakeeping data ► General data ► Problem setup ► 
Analysis type ► Time domain type: 1st order diffraction 
radiation

Seakeeping data ► General data ► Problem setup ► 
Environment: Waves

Seakeeping data ► General data ► Problem setup ► Type 
of analysis: Seakeeping

13.4.2. Problem description

Here, the data concerning domain depth and waves absorption 
is defined:

Seakeeping data ► Problem description

Bathymetry: Infinite depth
Wave absorption Yes

X absorption reference 0 m
Y absorption reference 0 m 

Absorption factor 1.0
Beach 20 m

Sommerfeld radiation 
condition Yes

13.4.3. Environment data
Here, the data concerning waves environment is set and 
defined:

Seakeeping data ► Environment data ► Waves

Wave spectrum Monochromatic wave
Amplitude 0.5 m

Period 3.58 s
Direction 0.0 deg

13.4.4. Time data
The simulation time data is to be set in this section.

Seakeeping data ► Time data

As the time step is already defined in the coupling data, the only 
data to be set is the following:

Output step 0.5 s
Start time recording 0.0 s

Initialization time 5 s

13.4.5. Body coupling

This condition is to be assigned to the body, so as to couple it 
with structural analysis:

Seakeeping data ► Body coupling

13.4.6. Numerical data
The relevant numerical data for this seakeeping problem can be 
set at:

Seakeeping data ► Numerical data

Solver Conjugate gradient
Preconditioner ILU

Free surface stability factor 1.0
Dynamic solver relaxation 0.25

Damping factor 0.05

13.4.7. Boundary conditions

The following boundary conditions are to be applied to the 
domain

To the top domain boundary surfaces:

Seakeeping data ► Boundary conditions ► Free surface

To the lateral domain boundary surfaces:

Seakeeping data ► Boundary conditions ► Outlet

To the domain volumes:

Seakeeping data ► Boundary conditions ► Fluid volume

13.5. Structural data
The following pages explain how to set the data corresponding 
to the structural part of the analysis.

13.5.1. General data
The structural analysis general data can be edited at:

Structural data ► General data

As a summary, the relevant data to be correctly set is the 
following:

Structural data ► General data ► Analysis

Element types Shells
Analysis type Dynamic Analysis

Material constitutive model Linear materials
Geometric constitutive 

model Non-linear geometry

Boundary conditions Linear boundary conds

The structural non-linear analysis data can be edited at:

Structural data ► General data ► Non-Linear analysis data

In this case, the default data is used.

The structural dynamic analysis data can be edited at:

Structural data ► General data ► Dynamic analysis data ► 
Integration data

Integration method Implicit (Energy 
conserving/decaying)

αE-C/D 0.0
Initial conditions None
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Structural data ► General data ► Dynamic analysis data ► 
Damping data

Damping type Rayleigh damping
αM 0.31315
αK 0.0

Regarding the chosen damping coefficient (αM), it is obtained as 
follows, in order to make it consistent with the damping used in 
SeaFEM. The damping coefficient has been calculated as the 5% 
of the critical damping, as showed next:

ξ=C/Cc=1

with:

C=M·α'M

Cc=2·M·ωc

So: 

α'M = 2·ωc

The frequency is calculated as:

ωc = √(K33/M) = 3.13155 s-1

with:

K33 = ρ·g·Aflot = 1.00518e+006 N/m

M: Total mass of the floater

In this case: αM = 0.05·(2·ωc) = 0.05·α'M = 0.31315

13.5.2. Constraints
The barge has been restrained in order to prevent its lateral 
movement. Therefore, only δy component has been restrained:

Structural data ► Constraints ► Fixed constraints

Activation Values
X constraint NO X value 0.0
Y constraint YES Y value 0.0
Z constraint NO Z value 0.0
θx constraint NO θx value 0.0
θy constraint NO θy value 0.0
θz constraint NO θz value 0.0

This constraint has been applied over the four lower corners of 
the barge (A, B, C, D):

13.5.3. Materials properties

An isotropic steel shell material condition has been applied to 
the barge geometry.

Structural data ► Materials and properties ► Shells ► 
Isotropic shell

-Thickness= 0.0523 m 

-E= 2.1e11 N/m2 (Young modulus)

-ν= 0.3 (Poisson coefficient)

-Specific Weight= 76900 N/m3

This condition must be applied to all the surfaces corresponding 
to the barge geometry in layer RamSeries>hull, as defined in 
Geometry generation.

The shell thickness has been adjusted in order to adjust the 
weight of the barge to the actual floating line corresponding 
displacement:

ΔV = L·B·d = 20*5* 1 = 100 m3

ΔM = ρw·ΔV = 1025*100 = 102500 kg

ρw·g·ΔV = ρM·S·t

t = ρw · g · ΔV
ρM · S = 1025 * 9.8 * 100

76900 * 250
= 0.0523m

13.5.4. Loads
In this case, three different loads must be applied.

 Hydrostatic load:

Structural data ► Loadcases ► Loadcase 1 ► Shells ► 
Pressure load

Factor Click Function icon to insert the 
following info:
Function on geometry 
(Hydrostatic load)
Reference coordinate = 0.0
Water specific weight 
=10055.3 N/m3

This load is to be applied to all the hull surfaces.

 Self-weight:

Structural data ► Loadcases ► Loadcase 1 ► Shells ► Self 
weight load
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This load is to be applied to all the hull surfaces.

 Seakeeping load (dynamic pressure coming from SeaFEM)

Structural data ► Loadcases ► Loadcase 1 ► Shells ► Body 
coupling load

This load is to be applied to all the hull surfaces which are under 
the water line.

13.6. Mesh generation

The mesh is generated with linear triangle and tetrahedra 
elements. 

The global mesh has a total of 42612 nodes, 18978 triangle 
elements, and 219846 tetrahedra elements.

13.6.1. Structural mesh
For the structural part of the goemetry, the following mesh sizes 
have been assigned:

Menu ► Mesh ► Unstructured ► Assign sizes on 
Surfaces/Lines/Points

Sizes on surfaces:

Sizes on lines:

Sizes on points:

13.6.2. Seakeeping mesh

For the seakeeping analysis geometry, the following mesh sizes 
have been assigned:

Menu ► Mesh ► Unstructured ► Assign sizes on 
Volumes/Surfaces/Lines/Points

Sizes on volumes:

Sizes on surfaces:

Sizes on lines

Sizes on points:

13.7. Postprocess

Once the analysis has finished, or even during the simulation, it 
is possible to access the postprocess, and visualize results:

Postprocess ► Start

One interesting aspect of this coupled simulation is that results 
of both analyses can be visualized simultaneously.

For example, it is possible to visualize the free surface 
deformation, and the structural shells deformation:



Compass - http://www.compassis.com
61

RamSeries tutorials manual

To do so, in the Postprocess menu/panel, do the following (after 
activating the corresponding meshes: free surface and shell 
structural mesh):

Postprocess panel ► Meshes

Postprocess panel ► Preferences ► Deformed ► Draw:[Yes]

Postprocess panel ► Preferences ► Deformed ► Factor:[1 
-1]

Postprocess panel ► Preferences ► Deformed ► Result 
(multiple):["Static Displacements"] ["Total elevation"]

Note that the sign of the deformation factor for the free surface 
depends on the orientation of the normal to the free surface. 
For a correct visualization, if the normal is pointing inwards, the 
factor shall be negative, and viceversa.

An animation of the results can be created from this 
deformation view:

Postprocess ► Animations

Visualization of contour fill of the different results (for structural 
or seakeeping analyses) can be done, in the usual way.

14. Tutorial 13 - Buckling analysis

This example performs a buckling analysis of a shell simply 
suported along all edges with in-plane uniaxial compression.

The next figure shows the geometry of the complete model.

L=508 mm

Since this model is symmetric, only a quarter of the model will 
be used to perform the buckling analysis.

The geometry corresponding to this tutorial can be found here 
(IGES format):

Ramseries-Tutorials13-buckling_shells.igs

Alternativelly, the model ready to be meshed and run, can be 
automatically loaded into the GUI by left-clicking on the button 
below.

Load model
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14.1. Analysis data

It is possible to run an Incremental Load Analysis combined 
with buckling analysis but for this example, an Static analysis is 
perfectly suitable.

General data ► Analysis ► Analysis type: Static

General data ► Analysis ► Linearized prebuckling analysis: 
Yes

Some particular parameters must be defined to perform the 
buckling analysis.

General data ► Buckling data

Num. of buckling modes 3
Imperfections factor 0.0

At least, the number of buckling modes must be one. The 
imperfections factor represents the amplitude of geometric 
imperfection related to the first buckling mode. In this example, 
the shell is considered ideal so a value of 0.0 is chosen.

All dimensions in this example are expressed in mm, so that, it 
is important not to forget to defined them.

Simulation data ► Units ► Geometry units: [mm]

14.2. Constraints
Since the plate is simply supported along all edges, the edges 
AD and DC shown in the next figure, must have Z direction 
fixed.

Structural data ► Constraints ► Fixed constraints

Activation Values
X constraint NO X value 0.0
Y constraint NO Y value 0.0
Z constraint YES Z value 0.0
θx constraint NO θx value 0.0
θy constraint NO θy value 0.0
θz constraint NO θz value 0.0

For applying symmetry condition, the following constraints 
must be added to AB:

Activation Values
X constraint NO X value 0.0
Y constraint YES Y value 0.0
Z constraint NO Z value 0.0
θx constraint YES θx value 0.0
θy constraint NO θy value 0.0
θz constraint YES θz value 0.0

To CB:

Activation Values
X constraint YES X value 0.0
Y constraint NO Y value 0.0
Z constraint NO Z value 0.0
θx constraint NO θx value 0.0
θy constraint YES θy value 0.0
θz constraint YES θz value 0.0

And to point B:

Activation Values
X constraint YES X value 0.0
Y constraint YES Y value 0.0
Z constraint NO Z value 0.0
θx constraint YES θx value 0.0
θy constraint YES θy value 0.0
θz constraint YES θz value 0.0

It is important to apply this point restrain after the previous line 
restrains have been applied.

14.3. Material properties

An isotropic shell material condition has been applied to the 
geometry.

Structural data ► Materials and properties ► Shells ► 
Isotropic shell

-Thickness= 3.175 mm 

-E= 2.062e5 N/mm2 (Young modulus)

-ν= 0.3 (Poisson coefficient)

-Specific Weight= 0.0 N/m3

14.4. Load
In this example, a compression load equal to the critical force 
(Nx) is applied to laterall contour line AD. Therefore, the setting 
Contour pressure will be used.

Loadcases ► Loadcase 1 ► Shells ► Boundary pressure load

Factor 1.0
Loadtype Global

X pressure 92.45 [N/mm]
Y pressure 0.0 [N/m]
Z pressure 0.0 [N/m]

14.5. Mesh
Buckling analysis can only be performed using meshes with 3-
node triangles. In this example, a structural mesh with 16 cells 
for each edge has been used.

Mesh ► Structured ► Surfaces ► Assign number of cells
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For obtaining a symmetric mesh like is shown in the previous 
figure, the following preference option must be set up:

Utilities ► Preferences ► Meshing ► Symmetrical 
structured: [Triangles] (Yes)

14.6. Results
After the analysis is calculated, the following results will be 
obtained:

Critical factor and buckling modes

The critical factor and buckling modes can be read from the 
process information of the analysis:

Calculate ► View process info

The amount of Eigenvalues calculated are= 3 .... 

The first 3 critical buckling load factors are:

Mode Fact_crit

 1 1.001

 2 2.785

 3 6.8

Postprocess

The following pictures show the three buckling modes for the 
performed analysis:

Postprocess panel ► Results ► Static ► Pre linearized 
buckling mode 1 ► Contour fill

Pre linearized buckling mode 1

Postprocess panel ► Results ► Static ► Pre linearized 
buckling mode 2 ► Contour fill

Pre linearized buckling mode 2

Postprocess panel ► Results ► Static ► Pre linearized 
buckling mode 3 ► Contour fill

Pre linearized buckling mode 3

15. Tutorial 14 - Impact between bottles

The aim of this tutorial is explaining the recommended steps to 
perform a simulation of impact between two bottles. It can also 
be used as a guide for impacts among other kind of objects.

This tutorial's manual is available in LogNoter format within the 
distribution of the software itself and can be accessed at any 
time during the working session of Ramseries by using the 
following option of the main menu:

Help ► Learning Tdyn ► Ramseries tutorials

This tutorial provides brief instructions to construct the 
geometry of the model from a bottle profile. The geometry of 
bottle's profile is included in the LogNoter version of this 
tutorial. This bottle's profile can be extracted from the following 
internal link:

bottle_profile.igs

This geometry can be also found and downloaded from the 
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support section of the compassis website: 
http://www.compassis.com/compass/en/Soporte

The igs files can be imported within Ramseries by using the 
following option of the main manu:

Files ► Import ► IGES

On the other hand, the geometry of this tutorial model can be 
extracted from the following internal link and can be used by 
the user as the starting point to reproduce this tutorial:

bottle_impact_shoulder.igs

Alternativelly, the model ready to be meshed and run, can be 
automatically loaded into the GUI by left-clicking on the button 
below.

Load model

15.1. Introduction
This example simulates an impact between two glass bottles on 
the shoulder. Both bottles are on a conveyor belt. One moves 
toward the other, that stands still, at a velocity of 0.6 m/s. In the 
following image the model is shown:

Impact between both bottles on the shoulder. Geometric model

15.2. Model's geometry

For performing any simulation, first you must define the 
geometric model. To start to draw the geometric model, the 
bottle's profile must be imported. At the beginning of this 
tutorial, it is explained how getting and importing the profile's 
model.

Bottle's profile

The surface have been splitted in the impact point, in this case, 
in shoulder. For doing so:

Geometry ► Edit ► Divide ► Surfaces ► Near point

First, a rotation extrude must be done. The points that define 
the rotation axis are shown in the following picture:

http://www.compassis.com/compass/en/Soporte
http://www.compassis.com/compass/en/Soporte
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Points that define the rotation axis to apply the extrusion to create the first bottle.

For doing the extrusion:

Utilities ► Copy

In the next picture the required parameters to create the first 
half bottle are shown. Only half bottle is created: symmetry 
constraints will be applied for performing an efficient 
simulation.

Extrusion operation using the bottle profile

For creating the second half bottle, the previous half bottle is 
copied applying a traslation.

A rotation of 7º is applied in the left bottle to assure the impact 
in the shoulder. This operation can be unnecessary depending 
on the impact zone. The rotation center is shown in the 
following image:

Center used to apply the rotation to the left bottle
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Parameters of rotation applied to the left botte

The geometric modes is already finished. However, it is 
recommended to create surfaces in contact area, and opposite 
areas inside bottles, for meshing these areas using smaller 
elements than in the remainder of the model.

Creation of contact area

For creating the contact area, it is recommended to apply the 
following steps:

Create a cylinder in the contact area as the following picture 
shows: 

Cylinder for creating the surfaces in contacta area and the opposite to them inside the 
bottle.

The radius of cylinder must be a little higher than the radius of 
contact area when the contact stress reaches the maximum 
value (3 mm for example).

Using the menu option 

Geometry ► Edit ► Intersection ► Superficies

the contact area and the opposite to them inside the bottles are 
created.

Defined areas to mesh with smaller elements

It is critical that the normals in the contact zone suerfaces are 
coherent. For doing so:

Utilities ► Swap normals ► Surfaces ► Make coherent

15.3. Loading Solids dynamic analysis

The first step to prepare a simulation using Tdyn is to select the 
type of analysis to be performed. This can be done within the 
Start Data window that appears by default the first time the 
user starts Ramseries. If the window does not appear by 
default, you can open it using the following option of the menu:

Data ► Start data

For this kind of problem, the Solids analysis can be set up from 
the Start Data window, as shown in the Beams tutorial, with the 
following options in this case:

- Simulation dimension: 3D

- Structural analysis: Solids

- Analysis type: Dynamic, Direct 
integration analysis

- Material constitutive model: Linear-
elastic model

- Geometrical constitutive model: Linear 
geometry

15.4. Analysis data

The parameters that must be defined in the data tree to 
perform the simulation are explained below. The rest of 
parameters can remain with the default values.

Simulation data ► Units ► Geometry units: mm

Gravity is vector is set towards the negative Y axis for this 
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example.

Simulation data ► Gravity

General data ► Analysis ► Element types: Solids

General data ► Analysis ► Analysis type: Dynamic analysis

General data ► Analysis ► Boundary conditions: Non-linear 
boundary conds

The following non-linear analysis parameters are chosen:

General data ► Non-linear analysis data ► General

Solver control Load control
Conv. tolerance 1.0e-3
Iteration type Full Newton-Raphson
Max iterations 40

The following dynamic analysis parameters are chosen:

General data ► Dynamic analysis data ► General

Type Direct integration

Δt (function)
Number of steps 600

The time steps are defined as a function:

Interpolation function at ΔSteps

ΔSteps Δt (s)
0 8.0e-7

600 5.0e-7

General data ► Dynamic analysis data ► Integration data

Integration method Implicit (Bossak-Newmark)
αB-N -0.05

Initial conditions User defined

 If Energy conserving method is chosen as integration method, 
it is ensured that energy will be constant during all simulation. It 
can be checked if Global parameters are activated. On the 
other hand, it is possible to use Bossak-Newmark method too.

General data ► Advanced ► Dynamic output

If Global parameters are activated, kinetic, elastic, potential and 
total energy will be calculated and written as results. 

Since the number of steps to be calculated is large, the size of 
results file can be heavy so, it is recomended an output step of 8.

General data ► Advanced ► Contacts data

Maximum admisible 
penetration (m) 0.025e-6

Normals sense swap 1
Contacts analysis method Full
Maximum admisible force 

(N) 0.5

Contacts analysis method Full is the most efficient option in this 
case because both bottles are hard, but when bodies are soft 
analysis may not converge. Simplified option improves the 
convergence, but needs more calculation time.

15.5. Constraints
Constraints in the plane of symmetry and in the base of bottles 
must be applied.

Constraints in the plane of symmetry

The constraint in the plane of symmetry must be elastic and its 
stiffness is 7e15 N/m2 in Z direction. To define this constraint:

Constraints ► Elastic constraints

Activatio
n Values

X 
constraint NO X value 0.0

Y 
constraint NO Y value 0.0

Z 
constraint YES Z value 7e15 

N/m2

This constraint must be assigned to the surfaces in the 
symmetry plane (Z=0)

Constraint in the base of bottles

A constraint that avoids displacement downwards but allows 
displacement upwards must be used to simulate a conveyor. 
Therefore, a non-linear elastic constraint must be applied in the 
base of the bottle.

For this reason, Y direction must be fixed and base surface must 
be selected.

Constraints ► Elastic constraints

Activatio
n Values

X 
constraint NO X value 0.0

Y 
constraint YES Y value (funct

ion)
Z 

constraint NO Z value 0.0

The function to be inserted is:

Function on Δy: Interpolation function at Δy

(Single value)

Δy (mm) Ky (N/mm2)
-1.0 -1000
0.0 0.0
1.0 0.0

This condition must be assigned to the heel of the bottle

Remember that it is necessary to select Non-Linear Boundary 
conditions in General data in order to be able to apply this 
constraint.

15.6. Contacts definition
In order to perform an impact simulation, it is required to define 
the type of contact (frictionless or sticking) and to assign the 
surfaces's bottles where the impact will be happen. For doing 
this, it is necessary to press the next Tdyn data tree option:

Contacts ► Contacts structural ► Master-Slave contacts 
Surf-Surf

This option is available only a type of non-linearity (material, 
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geometry or boundary conditions) has been activated. In this 
example, non-linear boundary conditions are selected.

If contact is frictionless, contact surfaces can slide but not if 
contact is sticking. In this case, contact must be frictionless.

Moreover, master and slave surfaces must be selected. It is 
recommended to choose surface of static bottle as master and 
the surface of bottle that is moved as slave.

Detail of master and slave surfaces. In this case, bottle on the left will move to the right one.

Checking normals of contact areas

In a simulation with contacts, it is very important that all master 
surfaces's normals must be coherent.

To see surfaces's normals the menu option

View ► Normals ► Surfaces ► Normal

must be used and then, master surfaces must be selected.

Master surfaces's normals are not coherent. One vector points to inside the bottle and 
other to outside.

As the previous image shows, both vectors are not coherent 
and one of them must be swapped. The menu option 

Utilities ► Swap normals ► Surfaces ► Make coherent

swaps normals of the selected areas. In this case, the upper 
surface is selected to swap its normal but the lower could be 
selected too.

Now, both normals are coherents.

15.7. Initial conditions
Initial conditions of displacement and velocity must be applied 
to the bottle that moves to the static bottle.

Only it is possible to define initial conditions if "User defined" is 
chosen in the parameter

General data ► Dynamic analysis data ► Integration data ► 
Initial conditions

Initial displacement to be applied depends on the distance 
between both bottle.

Dynamic conditions ► Initial conditions

In this case, an initial velocity of 0.6 m/s and initial displacement 
of 2.00275 mm to bottle on the left as the following picture 
shows.

Displacements x 2.00275 mm
Displacements y 0.0 mm 
Displacements z 0.0 mm

Velocity x 0.6 m/s
Velocity y 0.0 m/s
Velocity z 0.0 m/s
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An initial velocity and displacement are applied to bottle on the left.

15.8. Material properties

To assign the properties to both bottles the next option must be 
chosen in Tdyn data tree:

Material and properties ► Solids ► Isotropic solid

Material of both bottles is glass:

-E= 70.0 GPa(Young modulus)

-ν= 0.22 (Poisson coefficient)

-Specific Weight= 25000 N/m3

In this case, since glass is a material defined in the materials 
library it can be chosen and all properties are introduced 
automatically. 

If material properties are apply to both bottles separately, as it 
is shown in the picture below, then each bottle will have its own 
mesh in Postprocess and their mesh properties (visible, display 
style, etc...) can be changed separately too.

15.9. Loads
Self weight load must be assigned to both bottle using the next 
Tdyn data tree option:

Loadcases ► Loadcase 1 ► Solids ► Self weight load

15.10. Mesh generation

When the geometry of the model is drawn and all conditions 
have been assigned to it, then the mesh can be creating 
applying the following procedure:

The contact area and the opposite of them inside the bottle can 
be meshed with a structured mesh of triangles with a size of 0,2 
mm. For defining a structured mesh, the next menu option 
must be used:

Mesh ► Structured ► Superfaces ► Assign size

The remainder of the model can be meshed with a maximum 

element size of 5 mm

The mesh genereted using the options explained previously is 
shown below.

Detail of mesh in contact areas and the opposite to them inside the bottles.

General view of mesh

15.11. Calculate
When model's geometry is drawn, boundary conditions, 
material properties and the remainder simulation parameters 
are defined, and the mesh is generated, it is possible to run the 
simulation if the model has been saved. For saving the model 
use :

Files ► Save

And to run the simulation use the menu option 

Calculate ► Calculate
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The analysis runs as a separate process. Then, it is possible to 
continue working with GiD or exit the program. When the 
analysis is finished, a window will appear notifying it. If it has 
not run successfully, one window showing some error info will 
be supplied. Correct the error and run again.

It is possible to visualize, when the process is running, some 
information about its evolution. Press:

Calculate ► View process info

View of process info

In a simulation with contacts, the number of nodes contacted 
can change (new contacts created or old contacts removed) at 
the begining of each step. When convergence has been 
reached, contacts are changed another time and new iterations 
are calculated until convergence is reached another time. When 
there are not changes in contacts (creation and disconnection), 
then this time step has been calculated totally. For instance, the 
previous image it is shown that a new contact has been created 
and after convergence has been reached there has been not 
changes in contacts so this time step is finished.

It is possible that convergence is not reached. Reducing time 
step can be a possible solution in order to improve 
convergence.

15.12. Results
When simulation has been executed, then it is possible to see 
the results with the next menu option:

Postprocess ► Start

Some interesting results can be visualized, for example, Si-
Stress:

Postprocess panel ► Results ► Peso propio dynamic ► 
Stresses ► Si ► Contour fill

Si-Stress result at time step = 0.000252

Si-Stress result at time step = 0.000252 s in contact area

And the Animations control allows to show results of a specific 
time step or to make animations.

Postprocess panel ► Time step

Deformed meshes

Meshes can be deformed according to a vector result and a 
factor. When doing this, all results are drawn on the deformed 
meshes. For instance, it is possible to move bottles according to 
displacement result calculated in the simulation. The next image 
shows the same result as the previous images but deforming 
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meshes.

Postprocess panel ► Preferences ► Deformed ► Draw:[Yes]

Postprocess panel ► Preferences ► Deformed ► Factor:[1]

Postprocess panel ► Preferences ► Deformed ► 
Result:["Peso propio dynamic Displacements"]

View of contact area with deformed mesh using Displacement result

Time graph

It is possible to create a time graph of a result in a node or 
point. The next procedure must be applied to create a time 
graph:

Postprocess ► Mesh information

 Select a point or node (for example the node 10500)

 Press Time graph in Mesh information panel.

As shown in the next image, it is possible to see a specific value 
selecting a point with the left button of mouse in the time 
graph. The number of points in the time graph depens on the 
number of time steps in Animation control.

Time graph of Si-Stress of node 10500

Contact area

Contact area results is a specific result calculated in analysis 
with contacts. Nodes in slave surface and elements in master 
surface that are contacted, has a value of 1 and 0 the remainder 
of nodes and elements.

Postprocess panel ► Results ► Peso propio dynamic ► 
Contact area ► Contour fill

Contact area result in master surface at time step = 0.000252 s

Energy results

If Global parameters were activated in

General data ► Advanced ► Dynamic output

then it is possible to draw time graphs of kinetic, potential, 
elastic and total energy applying the next procedure:

Postprocess panel ► Results ► Peso propio dynamic ► 
Kinetic/Potential/Elastic strain/Total energy ► Contour fill
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Select the menu option 

Postprocess ► Mesh information

Select the node 1 because this results are stored in this node.

Press Time graph option in Mesh information panel.

As the following images shows, total energy is constant during 
all time of simulation if Energy conserving was selected in

General data ► Dynamic analysis data ► Integration data

Time graphs of kinetic, potential, elastic strain and total energy
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